


  

 
 
ALL RIGHTS RESERVED 
 
You may print one (1) copy of this document for your personal use.  Otherwise, no part of this document may 
be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language, in any 
form or by any means electronic, mechanical, magnetic, optical, or otherwise, without prior written 
permission from ALK Technologies, Inc. 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other 
countries. 

IBM is a registered trademark of International Business Machines Corporation. 

PC*MILER, CoPilot, ALK and RouteSync are registered trademarks of ALK Technologies, Inc. 

Truck Stop location data © Copyright 2015 Comdata Inc, 5301 Maryland Way, Brentwood, TN 
37027. All rights reserved. 

Traffic information provided by INRIX © 2015.  All rights reserved by INRIX, Inc. 

SPLC data used in PC*MILER products is owned, maintained and copyrighted by the National Motor Freight 
Traffic Association, Inc. 

Canadian Postal Codes data based on Computer File(s) licensed from Statistics Canada. © Copyright, HER 
MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of Industry, Statistics Canada 
2003-2015.  This does not constitute an endorsement by Statistics Canada of this product. 

Partial Canadian map data provided by GeoBase®. 

United Kingdom full postal code data supplied by Ordnance Survey Data © Crown copyright and database 
right 2015.  OS OpenData™ is covered by either Crown Copyright, Crown Database copyright, or has been 
licensed to the Crown. 

Certain Points of Interest (POI) data by Infogroup © Copyright 2015.  All Rights Reserved. 

Geographic feature POI data compiled by the U.S. Geological Survey. 

Oil and Gasfield content provided by GeoTrac Systems Inc.© Copyright 2015.  All rights reserved. 

Cartographic data provided by multiple sources including lnstituto Nacional de Estadistica y Geografia, U.S. 
Geological Survey, Natural Earth and © Department of Natural Resources Canada. All rights reserved. 

Copyright HERE Data © 2015 – All rights Reserved.  HERE Data © is subject to the terms set forth at 
http://corporate.navteq.com/supplier_terms.html . 

Source of map data for Mexico provided by Instituto Nacional de Estadistica y Geografia. 

All Retail Prices for Pilot Flying J locations are subject to change and are subject to Pilot 
Flying J’s disclaimer set forth at http://www.pilotflyingj.com/disclaimer . 

National Elevation Data produced by the U.S. Geological Survey. 

ALK Data © 2015 – All rights Reserved. 

ALK Technologies, Inc. reserves the right to make changes or improvements to its programs and documentation 
materials at any time and without prior notice. 
 
© Copyright 1994-2015 ALK Technologies, Inc. 
457 North Harrison Street, Princeton, NJ  08540 
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PC*MILER® Product Line 

 END-USER LICENSE AGREEMENT 
 

1.  Grant of License:  Subject to the terms, conditions, use limitations and payment of fees as set 
forth herein, ALK Technologies, Inc. ("ALK") grants the end-user ("you") a non-assignable, 
non-transferable, non-exclusive license to install and use the PC*MILER solution(s) 
(including traffic data and fuel subscriptions) you have purchased ("PC*MILER") on a single 
personal computer.  The PC*MILER software, data and documentation are provided for your 
personal, internal use only and not for resale.  They are protected by copyright held by ALK 
and its licensors and are subject to the following terms and conditions which are agreed to by 
you, on the one hand, and ALK and its licensors (including their licensors and suppliers) on 
the other hand. 

 
2.  Title:  You acknowledge that the PC*MILER computer programs, data, concepts, graphics, 

documentation, manuals and other material owned by, developed by or licensed to ALK, 
including but not limited to program output (together, “program materials”), are the exclusive 
property of ALK or its licensors.  You do not secure title to any PC*MILER program 
materials by virtue of this license. 

 
3.  Copies:  You may make one (1) copy of the PC*MILER program materials, provided you 

retain such copy in your possession and use it solely for backup purposes.  You agree to 
reproduce the copyright and other proprietary rights notices of ALK and its licensors on such 
a copy.  Otherwise, you agree not to copy, reverse engineer, interrogate, or decode any 
PC*MILER program materials or attempt to defeat protection provided by ALK for 
preventing unauthorized copying or use of PC*MILER or to derive any source code or 
algorithms therefrom.  You acknowledge that unauthorized use or reproduction of copies of 
any program materials or unauthorized transfer of any copy of the program materials is a 
serious crime and is grounds for suit for damages, injunctive relief and attorneys' fees. 

 
4.  Limitations on Transfer:  This license is granted to you by ALK.  You may not directly or 

indirectly lease, sublicense, sell, disseminate, or otherwise transfer PC*MILER or any 
PC*MILER program materials to third parties, or offer information services to third parties 
utilizing the PC*MILER program materials without ALK's prior written consent.  To comply 
with this limitation, you must uninstall and deactivate PC*MILER from your computer prior 
to selling or transferring that computer to a third party. 

 
5.  Limitations on Network Access:  You may not allow end-users or software applications on 

other computers or devices to directly or indirectly access this copy of PC*MILER via any 
type of computer or communications network (including but not limited to local area 
networks, wide area networks, intranets, extranets, the internet, virtual private networks, Wi-
Fi, Bluetooth, and cellular and satellite communications systems), using middleware 
(including but not limited to Citrix MetaFrame and Microsoft Terminal Server) or otherwise 
(including but not limited to access through PC*MILER interface products), or install or use 
PC*MILER on a network file server, without first notifying ALK, executing a written 
supplemental license agreement, and paying the license fee that corresponds to the number 
and types of uses to which access is to be allowed. 
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6.  Limitations on Data Extraction:  You may manually extract data (including but not limited to 
program output such as distances, maps, and driving directions) from PC*MILER and use it 
in other applications on the same computer on which PC*MILER is legally licensed and 
installed, as permitted below.  You may not transfer data extracted from PC*MILER onto 
any other computer or device unless you have licensed PC*MILER for that computer or 
device.  You agree that you will not, nor will you permit your trade partners or anyone else 
to, use content derived from PC*MILER, including route line data, nor display such data or 
integrate such data into another provider’s service, including, but not limited to, Google or 
Bing.  You agree not to pre-fetch, retrieve, cache, index, or store any data, content, or other 
portion of the product output at any time, provided, however, that you may temporarily store 
(for less than thirty (30) days) limited amounts of such content for the sole and exclusive 
purpose of enhancing the performance of your implementation due to network latency, and 
only if you do so securely and in a manner that: (a) does not permit use of the content outside 
of the scope of this Agreement; (b) does not manipulate or aggregate any content or portion 
thereof; (c) does not prevent ALK from accurately tracking usage; and (d) does not modify 
attribution of the product in any way. 

 
7. Limitations on Mobile Communications:  Without limiting the generality of the foregoing, 

you may not transmit PC*MILER street-level driving directions through mobile 
communications systems such as satellite, or cellular services or to mobile devices such as 
computers, telematics systems, on board or mobile computers or Smartphones, handhelds, 
pagers, electronic recording devices or telephones without first executing a written 
supplemental license agreement with ALK and paying the license fee that corresponds to the 
number and types of devices and systems to and through which transmission is to be 
permitted. 

 
8.  Limitations on Disclosure:  You may disclose PC*MILER distances to trading partners, in 

the course of their providing services to you, for specific origin-destination moves for which 
you provide transportation services and use PC*MILER distances as a basis for payment.  
You may not make any other disclosure of PC*MILER programs and materials, including, 
but not limited to, program output, to anyone outside the legal entity that paid for and holds 
this license, without prior written permission of ALK.  You acknowledge that the 
PC*MILER programs and materials, developed by or licensed to ALK are very valuable to 
ALK and its licensors, and their use or disclosure to third parties, except as permitted by this 
license or by a written supplemental license agreement with ALK, is strictly prohibited. 

 
9.  Security:  You agree to take reasonable and prudent steps to safeguard the security of the 

PC*MILER program materials and to notify ALK immediately if you become aware of the 
theft or unauthorized possession, use, transfer or sale of the PC*MILER program materials 
licensed to you by ALK. 

 
10. Acceptance:  You are deemed to have accepted the PC*MILER program materials upon 

receipt.  
 
11. Warranties:  ALK represents and warrants that: 
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a) For ninety (90) days from date of purchase, PC*MILER, when delivered and properly 
installed, will function substantially according to its specifications on a computer purchased 
independently by you. 
 
b) For ninety (90) days from date of purchase, the software media on which ALK provides 
PC*MILER to you will function substantially free of errors and defects.  ALK will replace 
defective media during the warranty period at no charge to you unless the defect is the result 
of accident, abuse, or misapplication of the product.  
 
c) THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING THE GENERALITY OF 
THE FOREGOING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR USE.  THE PC*MILER PROGRAM, DATA AND DOCUMENTATION 
IS SOLD "AS IS". IN NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR 
ANY INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT 
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE 
EXISTENCE OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM OF 
SOFTWARE, DATA OR SERVICES PROVIDED FOR IN THIS AGREEMENT.  IN NO 
EVENT SHALL DAMAGES TO WHICH ALK MAY BE SUBJECT UNDER THIS 
AGREEMENT EXCEED THE CONTRACT PRICE.  THIS WARRANTY SHALL NOT 
ACCRUE TO THE BENEFIT OF THIRD PARTIES OR ASSIGNEES. 

 
12. Disclaimer:  The data may contain inaccurate, incomplete or untimely information due to 

the passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  PC*MILER’s 
suggested routings, fuel and traffic data are provided without a warranty of any kind.  The 
user assumes full responsibility for any delay, expense, loss or damage that may occur as a 
result of their use.  The user shall have no recourse against Canada, whether by way of any 
suit or action, for any loss, liability, damage or cost that may occur at any time, by reason of 
possession or use of Natural Resources Canada data. 

 
13. Termination:  This Agreement will terminate immediately upon any of the following events: 
 

a) If you seek an order for relief under the bankruptcy laws of the United States or similar 
laws of any other jurisdiction, or a composition with or assignment for the benefit of 
creditors, or dissolution or liquidation, or if proceedings under any bankruptcy or insolvency 
law are commenced against you and are not discharged within thirty (30) calendar days. 
 
b) If you materially breach any terms, conditions, use limitations, payment obligations, or 
any other terms of this Agreement. 
 
c) Upon expiration of any written supplemental license agreement between you and ALK of 
which this license is a part. 

 
14. Obligations on Termination:  Termination or expiration of this Agreement shall not be 

construed to release you from any obligations that existed prior to the date of such 
termination or expiration. 
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15. Hold Harmless and Indemnity:  To the maximum extent permitted by applicable law, you 
agree to hold harmless and indemnify ALK and its parent company, subsidiaries, affiliates, 
officers, agents, licensors, owners, co-branders,  other partners, and employees from and 
against any third party claim (other than a third party claim for Intellectual Property Rights) 
arising from or in any way related to your use of PC*MILER, including any liability or 
expense arising from all claims, losses, damages (actual and/or consequential), suits, 
judgments, litigation costs and attorneys' fees, of every kind and nature. ALK shall use good 
faith efforts to provide you with written notice of such claim, suit or action. 

 
16. Disclosure for Products Containing Certain Data:  
 

a) Historical or Real-time Traffic data:  traffic data, including historical traffic data, is 
licensed as an optional subscription service which must be renewed annually for continued 
use.  ALK and its licensor(s) will use commercially reasonable efforts to make traffic data 
available at least 99.5% of the time each calendar month, excluding minor performance or 
technical issues as well as downtime attributable to necessary maintenance, and Force 
Majeure. 
 
b) Fuel data:  fuel data is licensed as an optional a subscription service which must be 
renewed annually for continued use.  
 
This data is provided to you “as is,” and you agree to use it at your own risk.  ALK and its 
licensors (and their licensors and suppliers) make no guarantees, representations or 
warranties of any kind, express or implied, arising by law or otherwise, including but not 
limited to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for a 
particular purpose, usefulness, use or results to be obtained from this Data, or that the Data 
or server will be uninterrupted or error-free. 

 
17. Limitations on Export:  You hereby expressly agree not to export PC*MILER, in whole or 

in part, or any data derived therefrom, in violation of any export or other laws or regulations 
of the United States. 

 
18. Aggregated Data:  ALK may, from time to time, share information about You with parent 

and sister or affiliated companies for business purposes and when necessary for it to perform 
work under this Agreement.  In addition, ALK may, and is hereby authorized to, use, share 
and provide certain aggregated, non-identifiable information derived from Your use of 
PC*MILER to third parties. 

 
19. ALK Cloud Feature:  ALK Cloud feature will store in anonymized way Your data in a cloud 

account in order to allow You to securely synchronize Your data with other users in Your 
organization.  End-user data is deemed the confidential information of end-user. For more 
information you may refer to ALK’s Privacy Policy. 

 
20. Additional Use Terms, Conditions, Restrictions and Obligations:  This agreement and your 

use of PC*MILER is expressly subject to the ALK Privacy Policy and the Navteq (HERE) 
and ALK End User License Agreement Terms and Conditions respectively  (“Navteq 
EULA”) and (“ALK EULA”) set forth below.  YOU ACKNOWLEDGE AND AGREE 
THAT YOU MAY NOT USE PC*MILER IF YOU DO NOT ACCEPT THE TERMS AND 
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CONDITIONS OF BOTH THE NAVTEQ AND ALK EULA AND THAT YOU 
ACKNOWLEGE THAT YOU HAVE REVIEWED AND ACCEPT THE TERMS AND 
CONDITIONS OF BOTH THE NAVTEQ AND ALK EULA BY INSTALLING OR 
ACTUALLY USING PC*MILER. 

 
21. Miscellaneous:  This agreement shall be construed and applied in accordance with the laws 

of the State of New Jersey.  The Courts of the State of New Jersey shall be the exclusive 
forum for all actions or interpretation pertaining to this agreement.  Any amendments or 
addenda to this agreement shall be in writing executed by all parties hereto.  This is the 
entire agreement between the parties and supersedes any prior or contemporaneous 
agreements or understandings.  Should any provision of this agreement be found to be 
illegal or unenforceable, then only so much of this agreement as shall be illegal or 
unenforceable shall be stricken and the balance of this agreement shall remain in full force 
and effect. 

 
22. Date:  This EULA was last updated on June 4, 2015. Visit www.pcmiler.com for regular 

updates. 
 
 
END USER LICENSE AGREEMENT FOR NAVTEQ (HERE) DATA 
 
This licence applies to NAVTEQ data included in your Software, if any, as well as to NAVTEQ 
data you obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  It is 
protected by copyright, and is subject to the following terms and conditions which are agreed to 
by you, on the one hand, and ALK Technologies Inc. (“ALK”) and its licensors (including their 
licensors and suppliers) on the other hand. 
 
© 2015 NAVTEQ.  All rights reserved. 

Personal Use Only.  You agree to use this Data together with PC*MILER for the solely personal, 
non-commercial purposes for which you were licensed, and not for service bureau, time-sharing 
or other similar purposes.  Accordingly, but subject to the restrictions set forth in the following 
paragraphs, you may copy this Data only as necessary for your personal use to (i) view it, and (ii) 
save it, provided that you do not remove any copyright notices that appear and do not modify the 
Data in any way.  You agree not to otherwise reproduce, copy, modify, decompile, disassemble 
or reverse engineer any portion of this Data, and may not transfer or distribute it in any form, for 
any purpose, except to the extent permitted by mandatory laws. Multi-disc sets may only be 
transferred or sold as a complete set as provided by ALK and not as a subset thereof. 

Restrictions.  Except where you have been specifically licensed to do so by ALK, and without 
limiting the preceding paragraph, you may not (a) use this Data with any products, systems, or 
applications installed or otherwise connected to or in communication with vehicles, capable of 
vehicle navigation, positioning, dispatch, real time route guidance, fleet management or similar 
applications; or (b) with or in communication with any positioning devices or any mobile or 
wireless-connected electronic or computer devices, including without limitation cellular phones, 
palmtop and handheld computers, pagers, and personal digital assistants or PDAs. 
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Warning. The Data may contain inaccurate or incomplete information due to the passage of time, 
changing circumstances, sources used and the nature of collecting comprehensive geographic 
data, any of which may lead to incorrect results. 
 
No Warranty.  This Data is provided to you “as is,” and you agree to use it at your own risk.  
ALK and its licensors (and their licensors and suppliers) make no guarantees, representations or 
warranties of any kind, express or implied, arising by law or otherwise, including but not limited 
to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for a particular 
purpose, usefulness, use or results to be obtained from this Data, or that the Data or server will 
be uninterrupted or error-free. 
 
Disclaimer of Warranty. ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS 
AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF 
QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OR NON-INFRINGEMENT.  Some States, Territories and Countries do not allow 
certain warranty exclusions, so to that extent the above exclusion may not apply to you. 
 
Disclaimer of Liability.  ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS 
AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM, 
DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE 
CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, INJURY OR DAMAGES, 
DIRECT OR INDIRECT, WHICH MAY RESULT FROM THE USE OR POSSESSION OF 
THE INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR 
SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR INABILITY TO 
USE THIS INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE BREACH OF 
THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR TORT 
OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and 
Countries do not allow certain liability exclusions or damages limitations, so to that extent the 
above may not apply to you. 
 
Export Control.  You agree not to export from anywhere any part of the Data provided to you or 
any direct product thereof except in compliance with, and with all licenses and approvals 
required under, applicable export laws, rules and regulations. 
 
Entire Agreement.  These terms and conditions constitute the entire agreement between ALK 
(and its licensors, including their licensors and suppliers) and you pertaining to the subject matter 
hereof, and supersedes in their entirety any and all written or oral agreements previously existing 
between us with respect to such subject matter. 
 
Governing Law.  The above terms and conditions shall be governed by the laws of Illinois, 
without giving effect to (i) its conflict of laws provisions, or (ii) the United Nations Convention 
for Contracts for the International Sale of Goods, which is explicitly excluded.  You agree to 
submit to the jurisdiction of the Illinois for any and all disputes, claims and actions arising from 
or in connection with the Data provided to you hereunder. 
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Government End Users: If the Data is being acquired by or on behalf of the United States 
Government or any other entity seeking or applying rights similar to those customarily claimed 
by the United States government, the Data is a “commercial item” as that term is defined at 48 
C.F.R (“FAR”) 2.101, is licensed in accordance with End-User Terms and each copy of Data 
delivered or otherwise furnished shall be marked and embedded as appropriate with the 
following “Notice of Use” and shall be treated in accordance with such Notice. 
 
Notice of Use 
Contractor (Manufacturer/Supplier) Name: NAVTEQ 
Contractor (Manufacturer/Supplier) Address: 425 W. Randolph Street, Chicago, Illinois 60606 
This Data is a commercial item as defined in FAR 2.101 and is subject to these End User Terms 
under which this Data was provided 
©2015 NAVTEQ- All rights reserved 
 
If the Contracting Officer, federal government agency, or any federal official refuses to use the 
legend provided herein, the Contracting Officer, federal government agency, or any federal 
official must notify NAVTEQ prior to seeking additional or alternative rights in the Data. 

 
 
END USER LICENSE AGREEMENT FOR ALK DATA  
 
This license applies to ALK Data included in PC*MILER if any, as well as to ALK data you 
obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  It is 
protected by copyright, and is subject to the following terms and conditions which are agreed to 
by you, on the one hand, and ALK Technologies, Inc. (“ALK”) and its licensors (including their 
licensors and suppliers) on the other hand. 
 
© 2015 ALK.  All rights reserved. 
 
1. Personal Use Only:  “You” means you as an End-user or as a “Company” on behalf of its 

End-Users which are subject to either a Non-Disclosure Agreement as employees or a 
License Agreement that contains the same restrictions as herein as a Value Added Reseller.  
Also as used in this EULA “personal use” can also be understood in more general terms as 
for a Company’s use. You agree to use this Data together with PC*MILER for the solely 
personal, non-commercial purposes for which you were licensed, and not for service bureau, 
time-sharing or other similar purposes.  Accordingly, but subject to the restrictions set forth 
in the following paragraphs, you may copy this Data only as necessary for your personal use 
to (i) view it, and (ii) save it, provided that you do not remove any copyright notices that 
appear and do not modify the Data in any way.  You agree not to otherwise reproduce copy, 
modify, decompile, disassemble or reverse engineer any portion of this Data, and may not 
transfer or distribute it in any form, for any purpose, except to the extent permitted by 
mandatory laws. 

 
2. Restrictions:  Except where you have been specifically licensed to do so by ALK in the case 

of an integrated solution bundled or intended for use with specific smartphones, similar 
mobile communication device(s) or personal navigation device(s), and without limiting the 

 
 PC*MILER Product End-User License Agreement vii 



  

preceding paragraph, you may not use this Data (a) with any products, systems, or 
applications installed or otherwise connected to or in communication with vehicles, capable 
of vehicle navigation, positioning, dispatch, real time route guidance, fleet management or 
similar applications; or (b) with or in communication with any positioning devices or any 
mobile or wireless-connected electronic or computer devices, including without limitation 
cellular phones, smartphones, palmtop and handheld computers, pagers, and personal digital 
assistants or PDAs. 

 
3. Warning:  The Data may contain inaccurate, untimely or incomplete information due to the 

passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  The Data is 
based on official highway maps, the Code of Federal Regulations, and information provided 
by state governments and other licensors.  It is provided without a warranty of any kind.  
The user assumes full responsibility for any delay, expense, loss or damage that may occur 
as a result of use of the Data.  

 
4. No Warranty:  This Data is provided to you “as is,” and you agree to use it at your own risk.  

ALK and its licensors (and their licensors and suppliers) make no guarantees, 
representations or warranties of any kind, express or implied, arising by law or otherwise, 
including but not limited to, content, quality, accuracy, completeness, effectiveness, 
reliability, fitness for a particular purpose, usefulness, use or results to be obtained from this 
Data, or that the Data or server will be uninterrupted or error-free. 

 
5. Disclaimer of Warranty:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR 
IMPLIED, OF QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT.  Some States, 
Territories and Countries do not allow certain warranty exclusions, so to that extent the 
above exclusion may not apply to you. 

 
6. Disclaimer of Liability:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT 
OF ANY CLAIM, DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF 
THE CAUSE OF THE CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, 
INJURY OR DAMAGES, DIRECT OR INDIRECT, WHICH MAY RESULT FROM 
THE USE OR POSSESSION OF THE INFORMATION; OR FOR ANY LOSS OF 
PROFIT, REVENUE, CONTRACTS OR SAVINGS, OR ANY OTHER DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OF OR INABILITY TO USE THIS 
INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE BREACH OF 
THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT 
OR TORT OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  Some 
States, Territories and Countries do not allow certain liability exclusions or damages 
limitations, so to that extent the above may not apply to you. 
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7. Export Control:  You agree not to export from anywhere any part of the Data provided to 
you or any direct product thereof except in compliance with and with all licenses and 
approvals required under, applicable export laws, rules and regulations. 

 
8. Entire Agreement:  These terms and conditions constitute the entire agreement between 

ALK (and its licensors, including their licensors and suppliers) and you pertaining to the 
subject matter hereof, and supersedes in their entirety any and all written or oral agreements 
previously existing between us with respect to such subject matter. 

 
9. Governing Law:  The above terms and conditions shall be governed by the laws of the State 

of New Jersey.  The courts of the State of New Jersey shall have exclusive jurisdiction to 
settle any and all disputes, claims and actions arising from or in connection with the Data 
provided to you hereunder.  You agree to submit to such jurisdiction. 

 
10. Canada:  DISCLOSURE FOR PRODUCTS CONTAINING CANADIAN POSTAL CODE 

AND/OR CANADIAN STREET-LEVEL DATA:  Based on Computer File(s) licensed 
from Statistics Canada. © Copyright, HER MAJESTY THE QUEEN IN RIGHT OF 
CANADA, as represented by the Minister of Industry, Statistics Canada 2003-2015. ALK 
Technologies, Inc. is an Authorized User of selected Statistics Canada Computer File(s) and 
Distributor of derived Information Products under Licensing Agreement 6147.  No 
confidential information about an individual, family, household, organisation or business 
has been obtained from Statistics Canada. You agree to indemnify Canada and its officers, 
employees, agents and contractors from all claims alleging loss, costs, expenses, damages or 
injuries (including injuries resulting in death) arising out of possession or use by Company 
of Natural Resources Canada data. 

 
========================================= 
ALK TECHNOLOGIES, INC. | www.alk.com 

=========================================. 
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Getting Started 
 

PC*MILER|Spreadsheets is a high performance engine for generating point-to-
point distances and drive times which can be easily integrated with Microsoft 

Excel.  It allows spreadsheet users to easily access PC*MILER distance 
information from within their spreadsheet program. 
 
With PC*MILER|Spreadsheets you can: 
 

• Benefit from the flexibility of the application.  This powerful 
product gives you the ability to customize PC*MILER for your 
own needs. 

• Build a database and let spreadsheet functions summarize and 
analyze your data, including price quotes, cost analysis, driver pay, 
operations analysis, lane analysis, and bill auditing. 

• Create new spreadsheet applications. 

• Calculate distances instantly within your spreadsheet (no need 
to copy and paste). 

• Optimize lane analyses and perform modal comparisons. 
 

1.1  Requirements 
PC*MILER|Spreadsheets requires a base installation of PC*MILER.  For a 
complete list of PC*MILER platforms and requirements, refer to the PC*MILER 
User’s Guide (see Accessing PC*MILER Product User’s Guides, section 1.5). 
 
Additionally, the Spreadsheets application requires: 
 

• 3 MB extra free space on your hard disk 
• Microsoft Excel 97 or higher already installed and working 
 

Optional: 
 

• PC*MILER|Streets for street-level detail in the U.S. and Canada 
• PC*MILER|Hazmat for hazardous material detail in the U.S. and 

Canada 
• PC*MILER|Tolls for toll cost calculations in the U.S. and Canada 
• PC*MILER|Worldwide for routing in regions outside of North America 

(Africa, Asia, Europe, Middle East, Oceania, and South America) 
• Canadian Postal Codes for access to related data 
• Standard Point Location Codes (SPLC) for access to related data 
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1.2  Installation 
PC*MILER|Spreadsheets is a PC*MILER add-on product that can be installed 
when you install PC*MILER or at a later time.  To install Spreadsheets along 
with PC*MILER, you simply make sure that “PC*MILER|Spreadsheets” is 
checked on the list of PC*MILER components when you are prompted during the 
installation process.  
 
If you are adding Spreadsheets at a later time, refer to the printed Getting Started 
Guide that came with your purchase of PC*MILER, or the PC*MILER User’s 
Guide that was included with the PC*MILER installation (see Accessing 
PC*MILER Product User’s Guides, section 1.5). 
 

1.3  The DEMO.xls Sample Workbooks 
The PC*MILER|Spreadsheets installation contains sample workbooks of all 
PC*MILER|Spreadsheets functions. They are a useful reference when you are 
learning how to use the application.  These files are located in the Excel folder in 
the PCMILER29 folder of your PC*MILER installation. Use these workbooks as 
a starting point, and then further customize each workbook for your own needs.  
 
Sample workbooks are available in the …\ALK Technologies\PCMILER29\ 
EXCEL ... folder: 

• DEMO_NA.xls – includes functions specific to general PC*MILER use 

• DEMO_NA_Tolls.xls – includes functions specific to PC*MILER|Tolls 
(PC*MILER|Tolls must be installed)  

• DEMO_WW.xls – includes functions specific to PC*MILER|Worldwide 
(PC*MILER|Worldwide must be installed)  

 
When you open one of these files, the first thing you’ll see is an introduction to 
PC*MILER|Spreadsheets with instructions for setup and using the demo file.  To 
go to the sample function applications, click on any other tab in the workbook.  
Function-specific instructions are under the spreadsheet in each tab.  Any cell that 
displays “#NAME?” can be activated to reveal the formula in the cell, just 
double-click it and press <Enter>. 
 
IMPORTANT: Make a backup copy of each sample workbook before making 
any changes to preserve the file’s original contents, layout and formatting. 
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1.4  Technical Support 
ALK Technologies offers one year of free unlimited technical support to all 
registered users of PC*MILER.  If you have any questions about 
PC*MILER|Spreadsheets or problems with the software that cannot be resolved 
using this User’s Guide, contact our staff:  
 
Phone: 1.800.377.6453, ext. 2 or 1.609.683.0220, ext 2 
Fax: 609.252.8108 
Email: pcmsupport@alk.com 
Web Site: www.pcmiler.com 
Hours: 9:00am – 5:00pm EST, Mon-Fri 
 
When calling, ask for “PC*MILER Technical Support”.  Please be sure to have 
your PC*MILER|Spreadsheets Product Key Code, version number, Windows 
version number, and hardware configuration information (manufacturer, speed, 
and monitor type) available before your call.  Please include this information in 
your message if you are contacting us by email. 

 

1.5  Accessing User Guides for PC*MILER Products 

NOTE: You must have Adobe Acrobat Reader on your computer to properly 
view a PC*MILER product’s user guide.  If you do not have this program 
installed already, a free copy can be downloaded from www.adobe.com.   
 
To make Adobe Reader your default reader, from within the Adobe Reader 
application select the Edit menu > Preferences > General and click Select Default 
PDF Handler.  Select Adobe Reader from the drop-down, and click Apply then 
OK to close the Preferences dialog. 
 
To view the user guide for any PC*MILER product without first opening an 
application, click the Windows Start button > All Programs (or the equivalent 
on your system) > PCMILER 29 > User Guides and select one of the .pdf files 
from the sub-menu. 
 
To search for a keyword or phrase in a user guide, use Adobe Reader’s Find 
option in the Edit menu or on the tool bar.   
 
All user guides can also be accessed at www.pcmiler.com/support. 
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1.6  Redistribution of PC*MILER|Spreadsheets 
Purchasing PC*MILER|Spreadsheets does not entitle you to redistribute any 
portions of this product. You may NOT redistribute ALK’s highway database, 
source code, interface definitions, or the PC*MILER|Spreadsheets Add-In or 
DLL. 
 
Your clients must purchase additional versions of the PC*MILER engine and 
database directly from ALK. ALK Technologies’ sales representatives can be 
reached at 1-800-377-MILE. 

 

1.7  Licensing 
Unless you buy additional licenses, only one copy of Excel at a time can attach to 
the highway database.  You can connect more client applications by purchasing 
additional database licenses from ALK (multi-user licenses). If you plan to 
connect many users to a network version of the PC*MILER database, ALK has 
attractive pricing for LAN versions. 
 

1.8  New and Recent Enhancements in Version 29  
New features and enhancements in Version 29 include: 
 

• ENHANCED!...Three toll discount programs have been discontinued  in 
Version 29 to reflect recent Toll Road Authority updates.  No new 
discount programs were added.   (PC*MILER|Tolls must be purchased 
and installed to calculate toll costs.) 

 
New features and enhancements in Version 28 include: 
 

• NEW!...The ability to use latitude/longitude points combined with street 
addresses.  See section 3.7.  (PC*MILER|Streets must be purchased and 
installed to use street addresses.) 

• ENHANCED!...The PC*MILER|Spreadsheets application’s memory 
consumption has been reduced. 

• ENHANCED!...The NEXUS toll discount program has been 
discontinued. (PC*MILER|Tolls must be purchased and installed to 
calculate toll costs). 
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Enabling and Disabling 
the Excel Add-In 

 
 
PC*MILER|Spreadsheets is an Add-In for Excel Version 5.0 or greater.  To 
complete the installation you must enable the Add-In manually from within Excel, 
or configure Excel to automatically load the Add-In each time you open the 
program. 

 

2.1  To Enable the Add-In Manually 
 
For  Microsoft Office 2003 (or older): 
 

1.  Open Excel. 

2.  In the top tool bar menu, select Tools > Add-Ins… > Browse. 

3.  Navigate to the folder where PC*MILER is installed and go to the Excel 
folder.   The default location of the Excel folder is …\ALK Technologies\ 
PCMILER29\Excel. 

4.  In the …\Excel folder, click on the Pcmsrv32.xla file then click OK. 

5.  In the Add-Ins dialog box, "PC*MILER|Spreadsheets" will appear in the 
list of products with a check next to it. This confirms that the Add-In is 
activated. 

6.  Click OK to continue. The setup is now complete. 
 
The PC*MILER|Spreadsheets functions are now ready to be used and will be 
available every time you start Excel. 
 
 

For Microsoft Office 2007 and 2010: 
 

1.  Open Excel. 

2. Click on the Microsoft symbol  in the upper left-hand corner of the 
screen (Excel 2007), or click on the File menu (Excel 2010). 

3.  In the list that opens, click on the Excel Options button at the bottom 
(Excel 2007) or the Options menu option (Excel 2010). 

4.  In the dialog box that opens, in the left-hand column menu click on Add-
Ins. 
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5.  In the right-hand side of the dialog box, there's a drop down menu next to 
Manage.  Select Excel Add-Ins if it is not already selected, then click the 
Go button to continue. 

6.  In the Add-Ins dialog box that opens, click Browse and navigate to the 
folder where PC*MILER is installed and go to the Excel folder (the 
default location is C:\ALK Technologies\PCMILER29\Excel). 

7.  In the …\Excel folder, click on the Pcmsrv32.xla file, then click OK. 

8.  In the Add-Ins dialog box, "PC*MILER|Spreadsheets" will appear in the 
list of products with a check next to it. This confirms that the Add-In is 
activated. 

9.  Click OK to continue. 

The remaining steps below are necessary only if you wish to turn off security 
warning messages for this spreadsheet. 

10.  Click on the Microsoft symbol      in the upper left-hand corner of the 
screen. 

11.   In the list that opens, at the bottom click on the Excel Options button. 

12.   In the dialog box that opens, in the left-hand column menu listing click 
on Trust Center.  Then click on the Trust Center Settings button on the 
right. 

13.   Click on Trusted Locations in the left-hand column menu. 

14.   Check if the location of the Excel folder from Step 6 is in the list of 
trusted locations; if not, click Add New Location… . 

15.   Click Browse… and navigate to the location of the Excel folder. 

16.   Select “Subfolders of this location are also trusted”, then click OK. 

17.  In the Trust Center, check “Allow Trusted Locations on my network”, 
then click OK.  The setup is now complete. 

 
 
The PC*MILER|Spreadsheets functions are now ready to be used and will be 
available every time you start Excel. 
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2.2  To Enable Autoloading of PC*MILER|Spreadsheets 
To have PC*MILER|Spreadsheets functions available without the manual Add-In 
process, copy the file pcmsrv32.xla from the Excel folder in your PC*MILER 
installation to the Excel startup folder on your computer. The startup folder is 
called XLSTART and is located in the folder where Microsoft® Excel is installed. 
 
For more information, see Excel Help under the search item “Startup folder”. 

 

2.3  To Disable the Add-In Manually 
1. Start Excel. 

2. For Microsoft Office 2003:  
Under the Tools menu, choose Add-Ins, then remove the check next to 
“PC*MILER|Spreadsheets” and click OK.   

 
For Microsoft Office 2007: 

Click the Microsoft Office button   , click Excel Options, and then click 
Add-Ins.  In the Manage pick list at the bottom of the window that opens, 
select Excel Add-Ins if it is not already selected. Then click “Go…” and 
remove the check next to “PC*MILER| Spreadsheets”, and click OK. 

 
For Microsoft Office 2010: 
Click File then Options to open the Excel Options dialog.  On the left, click 
Add-Ins.  In the Manage pick list at the bottom of the window that opens, 
select Excel Add-Ins if it is not already selected. Then click “Go…” and 
remove the check next to “PC*MILER| Spreadsheets”, and click OK. 

The PC*MILER|Spreadsheets functions are now removed. They will not be 
available the next time you start Excel. 

 

2.4  To Disable Autoloading of PC*MILER|Spreadsheets 
Remove the file pcmsrv32.xla from the Excel XLSTART folder. 
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Using PC*MILER|Spreadsheets 
 

There are two ways to use PC*MILER|Spreadsheets formulas in Excel: either 
type them directly into a cell or use the Insert Function option.  All formulas will 
accept strings for city name, and either strings or integers for ZIP codes. 
 
IMPORTANT NOTE:  Leading zeros are significant in numeric postal codes in 
many countries, for example in the USA, "504" is a 3-digit ZIP code centroid in 
central Wisconsin, whereas "00504" is a 5-digit ZIP code in Holtsville, New 
York. For that reason, we recommend that you always enter or import 
numeric postal codes as text strings (format cells as “Text” – see section 3.1 
below). If you do enter or import a postal code as an integer, be aware that 
Microsoft Excel will strip off leading zeros before that number gets to 
PC*MILER, for example if you enter the formula =miles(00504,504), 
PC*MILER will see that as =miles(504,504). In contrast, =miles("00504",504) 
will return the distance from the 5-digit ZIP code "00504" in Holtsville, New 
York to the 3-digit ZIP code area "504" in southeast Wisconsin. 
  

3.1  How to Format Cells and Enter a Formula 

• All city/state entries in Excel MUST contain a comma between the city name 
and state/country abbreviation, and – if you are using PC*MILER|Streets – all 
street addresses MUST be separated from the preceding place name by a 
semicolon.  Example: new york, ny;118 broadway. 

NOTE: For help with formatting street-level addresses in Spreadsheets, we 
provide a workbook with examples in the Excel folder of your PC*MILER 
installation folder (usually C:\ALK Technologies\PCMILER29\EXCEL).  Look 
in the “Other Formulas” tab of the DEMO_NA.xls file.   
 
• Columns must be formatted correctly so they can be read.  This is 

especially important when importing postal codes – if your columns are not 
properly formatted, the default spreadsheet format (“General”) will cause the 
first zero to be dropped from postal codes that begin with zero.  Also, columns 
containing calculated distances should be formatted so the desired number of 
decimal places appears.  To format columns: 

1.  Highlight a column you wish to format.   

2.  Right-click the column and select “Format Cells…”. 

3.  In the Number tab under Category, highlight “Number”, “Text”, 
“Currency”, or “Special > Zip Code”, depending on the type of data 
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the cells will contain. NOTE: All Number and Zip Code formatting 
accepts text too.  

4.  Set the options you want for each category; for example, the number 
of decimal places in the Number format.  Click OK when done. 

5. Repeat for all columns that you will be using. 
 

• To add a formula to a cell using the Excel Insert Function option (note that 
functions can also be entered manually in the formula bar): 

 
1. Select a cell, then select the Insert > Function menu command (for 

Microsoft Office 2007, Formulas tab > Insert Function) or click the 
fx speed button above the column headers.   
 
IMPORTANT:  Select a formula from the User Defined 
function category. All PC*MILER|Spreadsheets functions 
available through the Add-In are listed in this category. 
 

 
 

2. Enter cell references or other data in the Function Arguments window, 
click OK when done.  IMPORTANT: Options need quotes – for 
example, “prac” as in the screenshot below. 
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3.2  Time-Saving Tips 
If you need to copy and paste columns with a large number of calculated values 
into another worksheet or Excel file, use the Paste Special functionality to avoid 
waiting for values to recalculate: 
 
1.  Select the columns you want to copy. 

2.  Right click on the selection and choose “Copy”. 

3.  Right click again and choose “Paste Special”. 

4.  In the Paste Special dialog, select Values and click OK. 

 

 
5.  Paste the selection into another worksheet or Excel file. The calculated values 
will be pasted without the underlying formulas. 
 
DID YOU KNOW?  If you are new to Excel, you may not know that the contents 
of one or more cells can be copied into multiple cells with one click of the mouse. 
   

   
 
Formulas or values can be copied by selecting a cell or group of cells, then 
clicking on the square in the bottom right corner of your selection and dragging 
down or across the target column(s) or row(s). 
 
 
 
 
 
 
 
 
 

Click here and drag 
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3.3  Getting the Miles Between Two Points 
The prototype for the Miles function is: 
 
=Miles (origin, destination [, routing type]) 

NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
Miles returns the driving distance from the origin to the destination. The origin 
and destination may be designated as a city with a state abbreviation (e.g. Paris, 
TX), a postal code, or a custom place created in PC*MILER.  Any place name or 
postal code in the PC*MILER database may be used.  Three-digit U.S. ZIP codes 
representing centralized areas are now acceptable. Canadian Postal Code and 
SPLC add-on modules are also available – see section 3.6 on entering SPLC 
locations.     
 
Locations can also be entered as latitude/longitude points (see section 3.7, 
Entering Latitude/Longitude Points as Stops). 
 
If you are using PC*MILER|Streets, a street address may be added, separated 
from the place name by a semicolon (e.g. “kingston, nj; 16 laurel avenue”) – see 
NOTES below for PC*MILER|Streets users.  Beginning in Version 28, 
latitude/longitude points can be combined with street addresses  - see section 3.7. 
 
Miles returns -1 if the origin, destination, or routing type is not valid.  

 
Setting a routing type is optional.  Available route types correspond to those in 
PC*MILER (see the PC*MILER User’s Guide or Help for descriptions).  The 
default value is Practical. Options are: Prac (Practical), Short (Shortest), Natl 
(National Network), Toll (Toll Discouraged),  53Foot (53 Foot Trailer or Twins – 
see Note below), and Air (Air Distance). Route type entry is not case sensitive 
(e.g. “TOLL” or “Toll” is valid). 
 
NOTE: The default routing type is determined by the setting in PC*MILER 
(Route menu > Default Options > General tab) or in the PCMSERVE.INI file.  
Combination routing types (for example, Shortest and 53 Foot, or shortest and 
Toll Discouraged) can be accessed in Spreadsheets by 1) using “Ex” functions – 
see section 3.18, or 2) changing the default routing type in PC*MILER or in the 
PCMSERVE.INI. See section 3.13, Route Options and Default Settings, for more 
on routing options and section 3.12, Vehicle Dimension Options.  

 
The PC*MILER database contains several thousand cities and towns that share 
the same name. For instance, in Pennsylvania there are two towns named 
“Hamlin”. If there are multiple instances of the city name you enter, the Miles 
function will match to the first instance of the city name it finds as it searches the 
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database. For this reason, you may want to enter postal codes for the origin and 
destination rather than city names whenever possible.  

 
To see the full PC*MILER spelling and the postal code for a place name, you can 
use the CityName or FullName function described in this manual. 
 
Duplicate cities or towns that do not have a postal code assigned by the Postal 
Service are differentiated by the names of the counties in which they are located.  
The county name appears as part of the city name (e.g. Fairview, PA, Jefferson). 
For more information about how PC*MILER handles duplicate or multiple city 
names, see the Duplicate City Names section in your PC*MILER User’s Guide.  

 
NOTE: PC*MILER does NOT offer state centroid distances, you cannot get the 
distance from a central point in one state to a central point in another state. If 
states are referenced for the origin and destination in the Miles function and 
mileage is returned, it means that PC*MILER found locations in the database that 
had state names; for example, “Michigan, ND”.  In general it is recommended to 
use the =CityName function if stop validation is needed. 
 
NOTES for PC*MILER|Streets Users: When stops are city names or postal 
codes, by default “Highway Only” routing is used.  This routing uses an air 
distance from the midpoint of the highway segment that is nearest to the 
destination postal code or city/state. Routes to stops that include a street-level 
address are calculated to the highway-level road that is closest to the address.  
 
If “-1” is returned, or the miles that are returned do not match those generated in 
PC*MILER, try changing this option so that your route stays on local roads for as 
long as possible as it approaches a destination (PC*MILER will use local streets 
between the nearest highway segment and the stop).     
 
To change the default for this option, in the PCMSERVE.INI file (see Appendix 
B) set [Options] UseStreets=TRUE.  Also see section 3.13 for more about 
defaults, including order of precedence. 
 
To see an example of formatting street-level addresses into the format acceptable 
by PC*MILER|Spreadsheets, please see the Other Formulas tab of the 
DEMO_NA.xls workbook. 
 
MILES Function Examples: 
 

Origin  Destination Formula 
08540 12345 =miles(A2,B2, “prac”) 
H3B 1A2 Toronto, ON;797 Yonge St. =miles(A3,B3, “prac”) 
Ankeny, IA;200 East 1st St. Omaha, NE;1600 Douglas St. =miles(A4,B4, “short”) 
SPLC401167000 SPLC600143000 =miles(A5,B5, “short”) 
Beverly Hills, CA Medford, OR;48 Myers Court =miles(A6,B6,”53Foot”) 
Savannah, GA;25 Johnson Ct. 08528 =miles(A7,B7, “natl”) 
38.962955N,79.058204W,WV 39.618763N,98.094130W,KS =miles(A8,B8, “natl”) 
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El Paso, TX Cancun, QR =miles(A9,B9, “toll”) 
H3B 1A2 Moncton, NB =miles(A10,B10“air”) 

 
 

Example of Practical miles using cell references: 

 
 
 
 
Example of Shortest miles using cell references: 
 

 
 
 
 
Example of Air miles using cell references and street addresses: 
 

 
 
 
 
 
 

 
 PC*MILER|Spreadsheets User’s Guide 13 



 

 
Example of Practical miles with place names entered directly into the formula:   
 

 
 
 

NOTE: Notice in the above example that quotes are needed around the Canadian 
postal code “K7L 1B5” due to the space after “L”.  Spaces must be entered where 
they exist in postal codes and quotes must be used when entering a formula 
manually. 
 

3.4  Using Mexican Postal Codes 

NOTE: See section 3.13 on the order of precedence between settings in 
PC*MILER, the PCMSERVE.INI file and options set directly in Spreadsheets. 
 
Mexican Postal Codes are now accessible in the database.  Since U.S. ZIP Codes 
and Mexican Postal Codes share a similar naming convention, to ensure that the 
entered ZIP/Postal Code matches the desired location, there are settings available 
for the PCMSERVE.INI (see Appendix B), and function prototypes in 
PC*MILER|Connect.  The PCMSERVE.INI settings are:  

UseUSPostCodes=True/False 
UseMexPostCodes=True/False 
 
To add these setting options, do the following: 
 
1.  Open PCMSERVE.INI (this file can be found in your Windows or WINNT 

folder) using Notepad, Wordpad, or another text editor. 

2. Find the [OPTIONS] section. 

3. Under [OPTIONS] add the above lines (see below for valid combinations). 

4. Save and exit PCMSERVE.INI. 
 
The possible setting combinations are: 

• UseUSPostCodes=False and UseMexPostCodes=False – Defaults to the U.S. 
ZIP with no routing to Mexican postal codes 
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• UseUSPostCodes=True and UseMexPostCodes=False – Same as above 

• UseUSPostCodes=True and UseMexPostCodes=True – Defaults to the U.S. 
ZIP, must pass an Estados code to get Mexican location (e.g. “50510,EM”) 

• UseUSPostCodes=False and UseMexPostCodes=True – Only Mexican postal 
codes are available, in the U.S. only city-state pairs will get U.S. location (e.g. 
“Chico, CA”) 

 

3.5  Changing the “NL” Setting 
To accommodate the use of the “NL” abbreviation to conform to ISO 2-Character 
abbreviation standards, PC*MILER|Spreadsheets users can now choose whether 
to set NL to geocode to Newfoundland and Labrador locations in Canada or to 
Nuevo Leon locations in Mexico.  In PC*MILER, this setting is defaulted to Use 
NL for Newfoundland and Labrador.  If NL for Newfoundland and Labrador is 
the active option and you try to enter a Nuevo Leon location as an origin or 
destination, you will receive a -1 error message as the formula result. 
 
For Spreadsheets, this setting can be adjusted in the PCMSERVE.INI file as 
follows (this adjustment takes precedence over settings in PC*MILER, see 
section 3.13 on order of precedence): 
 
1.  Open PCMSERVE.INI (this file can be found in your Windows or WINNT 

folder) using Notepad, Wordpad, or another text editor. 
2. Find the [OPTIONS] section. 
3. Under [OPTIONS] add this line:  UseNLAbbrevInMX=True 
4. Save and exit PCMSERVE.INI. 
 
To reset back to the default choice, change =True to =False or delete the whole 
line and save your changes. 
 
NOTE: If you are using PC*MILER|Connect, an API is available to make this 
setting change.  The API takes precedence over the setting in the INI file, which 
takes precedence over the PC*MILER user interface. 
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3.6  Entering SPLCs as Stops 
(North America only – SPLC data must be installed)  To use SPLCs when 
entering origins/destinations, each number needs to be preceded by “SPLC”, e.g. 
“SPLC191690000”.  To add this text to a list of SPLC numbers, use the 
CONCATENATE formula as described in the steps below: 
 

1. To begin, all origin SPLC numbers should be listed in one column 
(column A in this example). 

 

2. Insert a new column to the left of column A. 

3. In the new column, add “SPLC” to each row that has a SPLC in it.  To do 
this quickly, type “SPLC” in cell A1, then click and drag the bottom right 
corner of the cell down the column (the cursor will become a plus sign).  
Let go when all target cells are populated with “SPLC”. 

 

4. Select a third column to the right (column C in this example) and make 
sure the cells are formatted as “General” or “Number”.   

5. In cell C1, manually enter the following formula: 
=CONCATENATE(A1,B1) 

6. Copy the formula down the remainder of the column as in Step 3. 
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7. With the third column selected, right click and select “Copy”.   

8. With the column still highlighted, right click and select “Paste Special”. 

9.  In the dialog that opens, select Values and hit OK.   

 

10. Delete the first two columns.  Your SPLC list is now correctly formatted. 

 

11. For the destination SPLC, follow steps 1-10 starting with column B 
instead of A. 
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12. When you have origin and destination columns set up, enter one of the 
PC*MILER calculation functions in the third column. Adjust the cell 
alignment and insert a header row if desired. 

 
 

 
 
 

3.7  Entering Latitude/Longitude Points as Stops 
PC*MILER|Spreadsheets enables you to enter latitude/longitude points as stops 
on a route.  These points can be entered in degrees minutes seconds format or 
decimal degrees (e.g. 0401750N,0742131W or 40.123N,100.333W). 
   

 
 
Degrees-minutes-seconds format: 
In degrees-minutes-seconds format the latitude and longitude are each 8 character 
strings in the following format: 

 
Characters 1-3  specify the degrees (be sure to include  leading zero if required) 
Characters 4-5  specify the minutes 
Characters 6-7 specify the seconds 
Character   8  is either ‘N’, ‘n’, ‘W’, or ‘w’ with N’s for latitude and W’s 

 for longitude  
 

Latitude and longitude must be separated by a comma WITHOUT A SPACE.  In 
general the format for a point is:   dddmmssN,dddmmssW. 
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Decimal degrees format: 
In decimal degrees format, latitude and longitude are strings of up to 8 characters 
representing a decimal number with up to 3 decimal places. No leading zeros are 
required. The decimal point counts as one of the characters. Latitude and 
longitude must be separated by a comma WITHOUT A SPACE. In general the 
format for a point is:   dddd.dddN,dddd.dddW. 
 
Converting between formats: 
To convert from degrees-minutes-seconds to decimal degrees use the following 
formula:   dddmmssN → ddd + mm/60 + ss/3600 . 
 
Examples: 
Here is an example of an actual lat/long near Kendall Park, NJ in both formats: 
 

0402515N,0743340W    or    40.421N,74.561W 
 
NOTE: To see an example of converting latitude/longitude coordinates from 
degrees minutes seconds to decimal degrees, please see the Other Formulas tab 
of the DEMO_NA.xls workbook. 
 
Beginning in Version 28, you can also use latitude/longitude points combined 
with street addresses for more precise geocoding and directions.  The lat/long is 
added before the address, followed by a semicolon.  An example is: 
 
40.211670N,74.703480W;1200 Kuser Road   
 
This new functionality will geocode the lat/long to the nearest point on the 
particular street in the address, rather than to the nearest street in the direction of 
travel, as would be the case for a lat/long by itself.  If the lat/long is more than .5 
miles from the street in the address, an error message will be returned. 
 
Here is a comparison of the results using the lat/long in the example cited above, 
with and without an address: 
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3.8  Worldwide Countries and European Postal Codes 
(For PC*MILER|Worldwide users) With PC*MILER|Worldwide data installed 
and the correct region specified (see section 3.13), you may specify a country 
outside North America using its FIPS two-letter abbreviation (for example, ‘Paris, 
FR’) or a postal code (for example, ‘46001 sp’).  For a list of state and country 
abbreviations by region, please see Appendix A. 
 
To use another format for the country abbreviation (ISO2, ISO3, GENC2, or 
GENC3) you will need to either change the format in PC*MILER or add a line to 
the PCMSERVE.INI file in the OPTIONS section (see Appendix B) as in the 
example below.  An INI setting takes precedence over a setting in PC*MILER. 
 
[OPTIONS] 
CountryAbbrevType=ISO2 
 
When you are using European postal codes as stops, you need to enter a 
country abbreviation to avoid being routed to the wrong country in cases 
where the same postal code exists in more than one country.  Enter the postal 
code, a comma or space, and the correct two-letter country abbreviation; e.g. 
“46001 sp” or “46001,sp” for Valencia, Spain. 
 
Canadian and Mexican locations are specified using a province or estado 
abbreviation after the city name.  Canadian postal codes are available as an add-
on. 
 
NOTE: Postal codes are accessible in other regions, though not all 
states/countries within that region have data available in PC*MILER. 
 

3.9  Changing the Region 
(PC*MILER|Worldwide only)  The prototype for the SetDefaultRegion function is: 
 
=SetDefaultRegion(regionName) 

 
NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
To enter location data for regions outside North America, there are two ways to 
select a region.  One way is to use the global SetDefaultRegion function in any 
cell of your worksheet.  After a region is set using this function, all cells in the 
worksheet except those that already contain calculations will be affected. In other 
words, all cells that don’t contain PC*MILER function calculations already will 
only process locations that are within the indicated world region.  This function 
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takes precedence over the equivalent setting in the PCMSERVE.INI file (see 
below) and the PC*MILER user interface.   
 
regionName is a string and valid values are as follows: NA (North America – 
this is the default), SA (South America), Europe, Africa, Asia, ME (Middle East), 
or Oceania. 
 
Alternatively, you can edit the PCMSERVE.INI file and change the region default 
from there.  This setting takes precedence over the Route Options setting in 
PC*MILER – the PC*MILER UI region setting is active only in the absence of 
the SetDefaultRegion setting in Spreadsheets or the Region setting in the INI file. 
Here are the steps to take to edit the PCMSERVE.INI file: 
 
1.  Find the PCMSERVE.INI file in your Windows or WINNT folder, and open it 

using Notepad or another text editor. 
 

2.  Find this line: 
 

[Default] 
Region=NA 
(If it is only “Region=” with no value, the default value “NA” is active.) 

 

3.  Type another region after “=”.  See choices for regionName above. 
 

4.  Save and close the file. 
 

5.  You must close and reopen Excel for the region change to take effect. 
 

3.10  Switching the Data Set 
The data set that PC*MILER|Spreadsheets uses to calculate routes can be changed 
using the PC*MILER user interface.  To do this, open PC*MILER then select the 
Map tab > Utilities group > Change Data Set > and choose a map data version 
from the menu.  For PC*MILER (North America only), possible options in the 
drop-down include the base version dataset as well as any mid-year versions* that 
have been released since the base version, including PC*MILER|Streets U.S. and 
Canadian street-level data if installed.  If PC*MILER|Energy has been purchased 
and installed, that dataset will also appear in the menu. 
* Only Annual Update Program (AUP) customers receive mid-year data releases. 
 
For PC*MILER|Worldwide users, local street address data is available in the U.S. 
and Canada, and in many countries in worldwide regions outside North America.  
Each module may be purchased separately or in combination with other data sets. 
 
PC*MILER|Spreadsheets must be restarted to activate the new data set. The 
correct data set must be activated before you enter an address.  Remember that the 
correct region must also be selected (see section 3.9 above). 
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3.11  Entering Location Names That Contain Accents 
Some PC*MILER location names include one or more accented letters.  An 
example of two locations that have the same name but are differentiated by an 
accented letter is Felipe Angeles, CI in Mexico.  The mileage difference shown 
below illustrates how important an accented letter can be in a location name: 
 

 
 

 
1.  To enter an accented letter, first type the location name in the cell and then, in 

the formula bar, select the letter that will be replaced (“A” in this example): 
 

 
 

 
2.  Now select the Excel Insert menu (not shown above) > Symbol (in Microsoft 

Office 2007 or 2010, after clicking “Insert”, look for the Omega sign to the 
far right in the tool bar) to open the Symbol window: 
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3.  Select the letter that you want (in this example, “Á”) and click Insert.  When 
you are finished, click Cancel to close the Symbol window. 

 
NOTE:  To search for an accented letter in a different font, make a selection from 
the Font pick list at the top of the Symbol window. 
 
 

3.12  Vehicle Dimension Options 
The same vehicle dimension route settings that the PC*MILER user interface and 
other PC*MILER interface modules have access to are now accessible in 
PC*MILER|Spreadsheets.  See the PC*MILER User’s Guide for more 
information on vehicle dimensions.   
 
The functions =Miles, =MilesEX, =Tolls, =TollsEx, =DiscountedTolls, and 
=DiscountedTollsEx have been updated to include the eight additional optional 
parameters that are listed below.  If these fields are left blank, the default settings 
will be used. 
 

 

Parameters 
English Inputs Metric Inputs 

Default  
Settings 

Acceptable  
Values 

Default  
Settings 

Acceptable  
Values 

Units 0 (ENGLISH) 0/1 1 0/1 

OverPerm 0 (False - i.e. 
not oversized) 0/1 0 0/1 

Height 162 (inches) > 0 - 162 4.11 (meters) > 0 - 4.11 
Width 96 (inches) 96, 102 2.44 (meters)  2.44, 2.59 
Length 48 (feet) > 0 14.63 (meters) > 0 
Weight 80000 lbs. 1000 - 132000 36290 kg.  454 - 60000 
Axle 5 2 - 14 5 2 - 14 
LCV 0 (False) 0/1 0 0/1 

 
 
The vehicle dimension options enable you to generate routes based on custom 
vehicle dimensions. Building on the foundation of PC*MILER’s previously 
existing routing database and routing options, users can now generate routing that 
conforms to the requirements of a vehicle’s height, length, width and weight. 
 
If a vehicle weight and/or height is entered, PC*MILER route calculations will 
take into account restrictions on roads and bridges to ensure that the vehicle’s 
weight/height is below the restriction(s).   
 
Vehicle weight, length and width information is checked against the threshold at 
which a truck becomes “oversized” and appropriate routing is generated. 
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NOTE: For PC*MILER|Worldwide users, you must first set the region.  See 
section 3.9 for instructions. 
 
Below is a sample function (=Miles) that includes vehicle dimension options: 

 
 

 
 
 

3.13  Route Options and Default Settings 
Default routing options that can be edited in the PCMSERVE.INI file include the 
route type, the unit of distance used in calculations (miles vs. kilometers), 
borders open/closed, the order of states/countries in the state/country summary 
report (alphabetical vs. travel order), and several others.  See Appendix B for 
details about the PCMSERVE.INI.  Keep reading below for additional important 
information on setting options. 
 
IMPORTANT:  Excel must be closed and reopened for changes set in the INI 
file or PC*MILER to take effect. 
 
Options may also be set in the Default Options dialog in PC*MILER.  The order 
of precedence for route option settings is as follows: 
 
1. Options that are set directly in Spreadsheets prevail over the default options 

set in PC*MILER and the INI file. 
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2. Options set in PCMSERVE.INI prevail over those set in PC*MILER. 

3. Options set in PC*MILER as defaults take effect only in the absence of 
settings 1 and 2. 

 

3.14  Getting State/Country Distances with Toll Costs 
The State/Country report lists toll, toll-free, ferry, and total distances by 
state/country.  If the PC*MILER|Tolls add-on module is installed with 
PC*MILER, the last column on the right in this report will also provide toll fees 
for each leg of a trip and the total toll amount for the whole trip.  
  
The steps to access this report vary depending on the version of Excel you are 
using.  With Excel open, follow the instructions below for your version: 
 
Excel 2003:  
Select an empty cell, then select PC*MILER State/Country Rpt… from the 
Excel Insert menu.   
 
Excel 2007 or 2010:  
Go to the Excel Add-Ins tab and click on PC*MILER State/Country Rpt.     

 
In the State/Country dialog box, enter a city name and state abbreviation or postal 
code for the origin and destination.  Select a Routing type if desired (the default 
is Practical), then click OK.  (For more on setting the route type, see section 3.3, 
Getting the Miles Between Two Points.) 
 
 

 
 

To have states or countries in the report listed in the order driven rather than 
alphabetically, change the default option in PC*MILER (Route menu > Default 
Options > General Options tab).  
 
You can also change the state/country order default using the PCMSERVE.INI 
file.  See Appendix B for more information about the PCMSERVE.INI. 
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Distances (and tolls, if the PC*MILER|Tolls add-on is installed) will be returned 
as in the example shown below (the generated report will use as many cells as 
needed in your spreadsheet).   
 
  

 
 

 

3.15  Getting the Drive Time Between Two Points 
The prototype for the DriveTime function is: 
 
=DriveTime (origin, destination [, routing type])  

 
NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
DriveTime returns the driving time (in minutes) from the origin to the destination 
calculated using the PC*MILER database. The origin and destination may be 
designated as a city/state abbreviation (e.g. Paris, TX), a five-digit postal code 
(Canadian Postal Code and SPLC add-on modules are also available). 
 
Any place name, postal code, or SPLC in the PC*MILER database may be used. 
You may also enter a latitude/longitude, or a custom place name created in 
PC*MILER.  If you are using PC*MILER|Streets, a street address may be added, 
separated from the place name by a semicolon; for example, “kingston, nj; 16 
laurel avenue”. 
 
NOTE: To see an example of formatting street-level addresses into the format 
acceptable by PC*MILER|Spreadsheets, please see the Other Formulas tab of 
the DEMO_NA.xls workbook. 
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Any place name, postal code, or SPLC in the PC*MILER database may be used. 
You may also enter a latitude/longitude, or a custom place name created in 
PC*MILER.  If you are using PC*MILER|Streets, a street address may be added, 
separated from the place name by a semicolon; for example, “kingston, nj; 16 
laurel avenue”. 
 
NOTE: To see an example of formatting street-level addresses into the format 
acceptable by PC*MILER|Spreadsheets, please see the Other Formulas tab of 
the DEMO_NA.xls workbook. 
 
DriveTime returns -1 if the origin, destination, or routing type is not valid.  
Below is an example of the Shortest drive time using cell references.  Time is in 
minutes, see “Hint” below for conversion. 
 
The routing type is optional and corresponds to the five PC*MILER routing types 
– see the PC*MILER User’s Guide or Help for descriptions of the different 
routing types – or an Air distance that is unique to PC*MILER|Spreadsheets. 
Options are: Prac (Practical), Short (Shortest), Natl (National Network), Toll 
(Toll Discouraged), 53Foot (53-Foot Trailer or Twins Routing), and Air (Air 
Distance). The default value is Prac. If Air is specified, the drive time will be 0.  
Route type input is not case sensitive (e.g. “SHORT” and “Short” are both valid). 

 
Note that to display drive times as “days hours:minutes” in Excel, you must first 
convert minutes to days by dividing by 24*60 in the DriveTime formula.  For 
example: 
 

                             =DriveTime (A2,B2)/(24*60) 

Then highlight the cells whose format you want to change, and select the 
“Cells...” command in the Format menu. 
   
In the Number tab, choose the “Custom” category then choose the applicable 
format or manually enter d <space>  hh:mm and click OK. 
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Example in days/hours/minutes: 
 

Origin Destination Formula RESULT 
(d hh:mm) 

90210 19027 =drivetime(A2,B2,”prac”)/(24*60) 1 20:18 
 
 

NOTE for PC*MILER|Streets Users: When stops are city names or postal 
codes, by default “Highway Only” routing is used.  This default can be changed in 
the PCMSERVE.INI file (see Appendix B).  See the note for Streets users in 
section 3.3, Getting the Miles Between Two Points. 

 

3.16  Getting Toll Data 
(In North America Only)  If the PC*MILER|Tolls add-on module is installed with 
PC*MILER, Spreadsheets will include two functions that calculate accurate, up-
to-date toll charges in the U.S. and Canada.  A sample spreadsheet using the Tolls 
functions is included in the EXCEL directory of the PC*MILER|Spreadsheets 
installation, the DEMO_NA_TOLL.xls file. 
  
The Tolls function works in the same way as the Miles function, with an extra 
parameter to indicate if discounted tolls should be used.   The prototype is: 
 
=Tolls (origin,destination,discount [,routeType])  

 
NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 

 

 
 
Tolls returns the total toll amount (in dollars) from the origin to the destination.  If 
discount is set to FALSE, all cash tolls will be used.  If set to TRUE, discount 
programs that are activated in PC*MILER (Route Options dialog > Tolls tab) 
will be used where they apply in computing tolls.  RouteType is an optional 
parameter that defaults to “Practical”.  (See section 3.3 for route type examples.) 
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The DiscountedTolls function returns the portion of the tolls for the trip 
attributable to the specified discount program.  If discountProgram is set to 
“Cash”, it returns the cash portion; if set to “EZPass” it returns the EZPass 
portion, etc.  The prototype is: 
 
=DiscountedTolls (origin,destination,discountProgram 

[,state][,routeType])  

Currently supported values for discountProgram are: 
 
 

Discount Program Valid In  Discount Program Valid In 
407 ETR Transponder ON Canada  I-Pass IL 
A25 Transponder QC Canada  K-Tag KS 
A30 EXPRESS 
Transponder QC Canada  Laredo Trade Tag TX 

BreezeBy OR  LeeWay FL 
Cruise Card GA  MACPASS NS Canada 
Downbeach Express 
Pass NJ  NC Quick Pass NC 

E-Pass TX  NEXPRESS TOLL MI 
ON Canada 

E-Pass Canada NS Canada  Palmetto Pass 
(PAL PASS) SC 

ExpressPass NY, ON Canada  Peach Pass GA 
EXpressToll CO  PikePass OK 
EZ Tag TX  Quickpass BC Canada 

EZPass 
DE, IL, IN, ME, MD, 
MA, NH, NJ, NY, NC, 
OH, PA, RI, VA, WV 

 
StraitPASS PEI Canada 

EZPass-NJ NJ  SunPass FL 
EZPass-WV WV  TollTag LA, TX 
FasTrak CA  TReO BC Canada 
GeauxPass LA  TxTag TX 
Good To Go WA  Wabash Pass IN 
GO-PASS CO    

  

 
SPECIAL NOTE:  The “EZPass-WV” or “EZPass-NJ” options apply to those who 
purchased the EZPass service in West Virginia or New Jersey. 
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The following discount programs have been discontinued in the database: 
 
Discontinued 
Program 

State Versions 
Available 

Version 
Discontinued 

Reason 

C-Pass FL  29 Adopted SunPass 
FAST LANE MA  

and all 
EZPass 
facilities 

 29 Only EZPass is used now 

Smart Tag VA  29 Only EZPass is used now 
NEXUS NY, ON 27 28 Discontinued 
I-Zoom IN 21-26 27 Replaced by EZPass 
B-Pass NB 17-25 26 Toll discontinued 
M-Tag MD 17-23 24 Replaced by EZPass 
NH Tokens NH 17, 18 19 Replaced by EZPass 
O-Pass FL 21-23 24 Absorbed into SunPass 
Ready Toll OH 17, 18 19 There is no discount 

associated with this program, 
it’s simply a “debit card” used 
to pay tolls 

Transpass ME 17- 23 24 Replaced by EZPass 
 
 
The discountProgram values must be spelled as shown in the Route Options 
dialog > Tolls tab in the PC*MILER application.  (Spaces and dashes must be 
entered exactly as they appear there, but case does not matter (e.g. “E-Pass” or “e-
pass” are both acceptable).  If a state is specified, only the tolls in that state are 
returned.  If the state is missing or an empty string, all states are included.  In the 
example below, the toll costs in New Jersey using EZPass are calculated.  

 
 

NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
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NOTE: To get toll costs by state for a whole route, use the State/Country Report 
described in section 3.14. 

 
NOTE: There are no settings available in PC*MILER|Spreadsheets to calculate 
time-based toll costs.  The reported toll costs are at the highest rate, or the  peak 
rate for the route. 
 

3.17  Calculating Air Distance 
PC*MILER|Spreadsheets is now able to calculate the straight line or “Air” 
distance between two points.  “Air” is a sixth route type option for the Miles 
routing function, in addition to Short, Prac, Natl, Toll, and 53Foot.  
  
For the Air distance, points are specified the same way as in other 
PC*MILER|Spreadsheets distance calculations, as either city/state, five digit U.S. 
ZIP [Canadian Postal Code and SPLC add-on modules are also available], or 
latitude/longitude.  This is an example of Air distance using cell references: 
 

 
 

3.18  Ex Functions for Combination Route Types 
Four ‘Ex’ functions have been added to PC*MILER|Spreadsheets to make using 
combination route types easier (for example, Shortest with Toll-Discouraged 
routing).   
 
=MilesEx(origin, destination [, routing type]) 

=DriveTimeEx(origin, destination [, routing type]) 

=TollsEx(origin,destination,discount [,routing Type])**  

=DiscountedTollsEx(origin,destination,discountProgram 
[,state][,routing Type])**  

**  These functions are only available if the PC*MILER|Tolls add-on module is installed. 
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Previous to Version 20, to use combined route types in Spreadsheets the 
CalcType setting had to be altered in the pcmserve.ini file (see Appendix B).  This 
still works and is the only way to set the default route type across functions.   
 
However, the Ex functions shown above now provide the ability to use any of the 
combination route type parameters listed below:  
 
• prac|toll (Practical and Toll Discouraged) 
• prac|53foot (Practical and 53-Foot Trailer or Twins) 
• prac|natl (Practical and National Network) 
• prac|toll|53foot (Practical, Toll Discouraged, 53-Foot Trailer or Twins) 
• prac|toll|natl (Practical, Toll Discouraged, National Network) 
• short|toll (Shortest and Toll Discouraged) 
• short|53foot (Shortest and 53-Foot Trailer or Twins)  
• short|natl (Shortest and National Network) 
• short|toll|53foot (Shortest, Toll Discouraged, 53-Foot Trailer or Twins) 
• short|toll|natl (Shortest, Toll Discouraged, National Network) 
 
The pipe symbol ( | ) is created by holding down the Shift key and the backslash 
key ( \ ) on your keyboard at the same time. 
 
Examples: 
 
Origin Destination Formula 
08540 02205 =MilesEx(A2,B2, “prac|toll”) 
08540 02205 =DriveTimeEx(A3,B3,“prac|toll”)/(24*60) 
08540 02205 =TollsEx(A4,B4,TRUE, “prac|toll”) 

 
 

 
 
 
NOTE: Sample workbooks using these functions are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
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3.19  Getting the City Name from a ZIP/Postal Code 
The prototype for the CityName function is: 
 
=CityName (ZIPCode) 
 

NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
CityName returns the city name and state or country abbreviation corresponding 
to the given postal code. (Canadian Postal Codes, SPLC, and 3-digit U.S. ZIP 
codes representing centralized areas are now valid with this function, as are 
international postal codes if you are a PC*MILER|Worldwide customer.) 
CityName returns -1 if the postal code you entered is invalid.   
 

 

 
 

CityName Function Examples: 
 

Input Formula RESULT 
80903 =cityname(A2) Colorado Springs, CO 
SPLC191690000 =cityname(A3) Newark Airport, NJ 
H3B 1A2 =cityname(A4) Montreal, QC 
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3.20  Getting the ZIP/Postal Code from a City Name 
The prototype for the ZIPCode function is: 
 
=ZIPCode (City,State) 

NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.   

 
ZIPCode returns the postal code corresponding to a place name. The place name 
is a city with a state or country abbreviation (e.g. Austin, TX or Sion, FR). Any 
place in the PC*MILER database may be used, with the exception of Canadian 
place names. ZIPCode returns a -1 if the place name you entered is invalid. 

 
The ZIPCode function can be used to test if a given number is a valid postal code.  
For example, the following Excel command will return TRUE if cell B2 contains 
a valid postal code and FALSE if it does not: 
 
                            =NOT (EXACT(-1,ZIPCode(B2))) 
 

 
 

 
Neither postal codes outside of the U.S. nor SPLC’s can be derived from this 
function.  However, Canadian and Worldwide codes can be found using the 
Location Lookup dialog.  The steps to access the Location Lookup vary 
depending on the version of Excel you are using:  

Excel 2003: 
In Excel 2003, select Insert menu > PC*MILER Location Lookup…, then 
enter a city/state (example: ‘Montreal, QC’ – see below) and click Lookup.  
Make a selection from the pick list.   

Excel 2007 or 2010: 
Click the Add-Ins tab and select PC*MILER Location Lookup…, then enter a 
city/state (example: ‘Montreal, QC’ – see below) and click Lookup.  Make a 
selection from the pick list. 
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3.21  Getting the Full ZIP/Postal Code and City Name 
The prototype for the FullName function is: 
 
=FullName (ZIPCodeOrCityState) 

NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
FullName returns the postal or SPLC code, city/state abbreviation, and county 
name corresponding to the given location. Any place name, postal code, or SPLC 
in the PC*MILER database may be used (Canadian Postal Codes included in 
PC*MILER, and international postal codes are additionally available for 
PC*MILER|Worldwide customers).  FullName returns -1 if the PC*MILER 
place you entered is invalid.  

  
HINT:  If a Canadian city, Canadian postal code, or SPLC is entered in the 
function, it will return the city/state without a code.   

 

 
 
 
FullName Function Examples: 

 

 

Location Formula RESULT 
52802 =fullname(A2) 52802 Davenport, IA, Scott 
Hershey, PA =fullname(A3) 17033 Hershey, PA, Dauphin 
R3L 0B5 =fullname(A4) R3L 0B5 Winnipeg, MB 
SPLC301120002 =fullname(A5) 301120002 Canal, MI, Chippewa 
Paris, FR =fullname(A5) Paris, FR, Paris 
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3.22  Getting the City Name/State/County from a Location 
The prototype for the CityNameWithCounty function is:  
 
=CityNameWithCounty (placeName) 

 
NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
The function CityNameWithCounty takes a PC*MILER location (city-state, 
postal code, six-digit Canadian Postal Code, PC*MILER|Worldwide international 
postal code, SPLC, PC*MILER custom name) and returns the city name with 
state and county.  Any place name, postal code, or SPLC in the PC*MILER or 
database may be used. Returns -1 if the PC*MILER place you entered is invalid. 

 

 
 
 

CityNameWithCounty Function Examples: 
 

Location Formula RESULT 
Knoxville, IA =citynamewithcounty(A2) Knoxville, IA, Marion 
12345 =citynamewithcounty(A3) General Electric, NY, Schenectady 
SPLC401167000 =citynamewithcounty(A4) Barco, NC, Currituck 
Omaha, NE;1600 Douglas St. =citynamewithcounty(A5) Omaha, NE, Douglas 
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3.23  Getting Latitude/Longitude Points from a Location 
The prototype for the CityToLatLong function is: 
 
=CityToLatLong (CityStateOrZipcode) 

 
NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
The function CityToLatLong takes a PC*MILER location (city-state, postal 
code, SPLC, truck stop, PC*MILER custom name) and returns the 
latitude/longitude of a point central to the location in degrees, minutes, seconds 
format (dddmmssN,dddmmssW). CityToLatLong returns -1 if the PC*MILER 
place name you entered is invalid. 

 

 
 
CityToLatLong Function Examples: 

 
Location Formula RESULT 
52802 =citytolatlong(A2) 0413114N,090438W 
Hershey, PA =citytolatlong(A3) 0401707N,0763859W 
R3L 0B5 =citytolatlong(A4) 0495251N,0970830W 
Ankeny, IA;200 East 1st St. =citytolatlong(A5) 0414400N,0933640W 
SPLC301120002 =citytolatlong(A6) 0462918N,0842104W 

 
 
IMPORTANT NOTE for PC*MILER|Worldwide Users:  The appropriate 
region must be set in PC*MILER to match the input locations. Also, when 
entering abbreviations for countries outside North America (for example, Paris, 
FR), the format must match the setting in PC*MILER (Tools menu  > Country 
Abbreviations) – either FIPS 2-character, FIPS 3-character, or ISO 2-character. 
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3.24  Getting a Place Name from Lat/Long Points 
The prototype for the LatLongToCity function is: 
 
=LatLongToCity (LatLong) 

NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
The function LatLongToCity takes a latitude/longitude (degrees, minutes, 
seconds or decimal degrees format) and returns the miles from the PC*MILER 
place name at the closest end of the closest road segment.  This may be either a 
city-state or a road intersection.  This function connects latitude/longitudes to the 
highway network as if you were routing to or from the latitude/longitude.  
LatLongToCity returns a -1 if the lat/long format is invalid or is more than 200 
miles from a road in the PC*MILER highway network. 

 
The CityToLatLong and LatLongToCity functions may be, but are not 
necessarily reversible, because not all PC*MILER place names are located at the 
end points of road segments.   

 

 
 

LatLongToCity Function Examples: 
 

Location Formula RESULT 
0401707N,0763859W =latlongtocity (A2) 0.0  PA State Univ-Hershey Medical, PA, Dauphin 
0495255N,0970818W =latlongtocity (A3) 0.1  E Winnipeg, MB 
0462918N,0842104W =latlongtocity (A4) 0.0  Canal, MI, Chippewa 

 

 
IMPORTANT NOTE for PC*MILER|Worldwide Users:  The lat/longs 
entered must match the region set in PC*MILER.  In North America, city returns 
will include state, province, or estado but not country.  In all other regions, the 
city and country will be returned, with the country abbreviation being a FIPS 2-
character, ISO 2-character, or FIPS 3-character, depending on the setting in 
PC*MILER (Tools menu  > Country Abbreviations). 
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3.25  Getting Latitude/Longitude Points from an Address 
 

=AddressToLatLong (Address) 

 
NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
(In North America with PC*MILER|Streets only)  This function takes a 
PC*MILER|Streets address and returns the latitude/longitude in degrees, minutes, 
seconds format (dddmmssN,dddmmssW). AddressToLatLong returns -1 if the 
place name you entered is invalid.  The function may be, but is not necessarily 
reversible.  For a decimal format return, see Appendix B on the PCMSERVE.INI. 
 

 
 

 

3.26  Getting an Address from Latitude/Longitude Points 
 

=LatLongToAddress (LatLong) 

 
 (In North America with PC*MILER|Streets only)  This function takes a 
latitude/longitude (degrees, minutes, seconds or decimal degrees format) and 
returns the address. This function connects latitude/longitudes to the highway 
network as if you were routing to or from the latitude/longitude.  
LatLongToAddress returns a -1 if the lat/long format is invalid or is more than 
200 miles from a road in the PC*MILER|Streets highway network. The function 
may be, but is not necessarily reversible. 

 
NOTE:  The output of this function has been enhanced so that, for roads that have 
both a street name and a route number, the route number will be returned in 
parentheses after the street name.  
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For example, in Version 29 and higher:  
=latlongtoaddress(addresstolatlong("Princeton, NJ; 245 Nassau Street")) returns  
08540 Princeton, NJ, Mercer; 245 Nassau Street (NJ-27). 

 
 

 
 

 
NOTE:  Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 

3.27 Multi-Stop Routes 
A good way to calculate a multi-stop route is to put all stops along the route, 
including the origin and destination, in the same column: 
 

 
   
 
In the example above, the origin is in cell B3, the first stop is in B4, second stop 
in B5, etc.  The Miles formula was entered in cell C4 to get the mileage from 
08540 to Baltimore, MD; i.e. =Miles(B3,B4).  This formula was then dragged 
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from C4 down the length of the stop list to obtain leg mileages.  (To replicate a 
formula down a column, click and hold the small square in the bottom right 
corner of the cell that contains the formula and drag down over the other cells in 
the column.  See Excel Help for more about this and other Excel spreadsheet 
capabilities.)  For more examples, see the “Demo*.xls” files in the Excel folder of 
your PC*MILER installation. 
 
Total mileage was added at the bottom using the Excel function =SUM(C4:C9) to 
add up all miles in the “Mileage” column. 
 

3.28  Hub Routes 
Using the same principle as for multi-stop routing above, Hub mileage (mileage 
from one “hub” location to multiple destinations) can be derived by entering the 
hub location at the top of a column and placing multiple destinations under it in 
the same column.   
 
Simply set the origin in the =Miles formula in each cell to the stop at the top of 
the list; in the example below, to get miles from 08540 to Atlanta,GA, cell C6 
contains the formula =Miles(B3,B6). 
 

 
 
 
NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
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3.29  Getting Toll Data from Lat/Longs 
If PC*MILER|Tolls was purchased and installed, toll data can be calculated in 
PC*MILER|Spreadsheets using latitude/longitude points. 

 
In the example below, the Discount parameter is set to TRUE so that discount 
programs that are activated in PC*MILER (Options dialog > Tolls tab) will be 
used where they apply in toll calculations.  The RouteType optional parameter is 
missing and therefore defaults to Practical routing.  See section 3.16 for more on 
the Tolls function. 

 

 
 
NOTE: Sample workbooks using this function are in the Excel folder of your 
PC*MILER installation, usually in C:\ALK Technologies\PCMILER29\EXCEL.  
See section 1.3 for a description of the provided workbooks.  
 
 

3.30  Using the Avoid/Favor/Override Roads Option 
If the “Custom” option is turned on in the PCMSERVE.INI file (see below), 
PC*MILER|Spreadsheets will use the avoid/favor/override road settings created 
in PC*MILER.  Note that favoring a road does not absolutely guarantee that it 
will be used (see the PC*MILER User’s Guide or Help for a description of 
avoiding, favoring, and overriding roads).  
 
This option can also be set by changing the CustomRoute setting to TRUE in the 
PCMSERVE.INI file located in your Windows or Windows NT folder.  The 
default is FALSE.  See Appendix B for more about the .INI file.  
 
=CustomRoute=TRUE 
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3.31  Using Hazardous Materials Compliant Routing 
(North America only)  If the separate PC*MILER|HazMat add-on module has 
been purchased, PC*MILER|Spreadsheets can calculate routes that are hazardous 
material compliant for various types of hazardous material. See the PC*MILER 
User’s Guide or Help for a description of the following available PC*MILER 
hazmat route types:  
 
 In North America:  None, General*, Explosive, Inhalant, Radioactive, 

Corrosive, or Flammable. * “General” = “Other” in the PC*MILER UI. 
 In Europe and Oceania (PC*MILER|Worldwide must be installed): None, 

General, Explosive, Flammable, HarmfultoWater 
 
The hazardous material routing type can be set as the default in the PCMSERVE.INI 
file (HazRoute setting).   See Appendix B for more about the .INI file.  
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Trouble-shooting 
 
 

 ‘Run-time error 1004’ 
 
If you get the error “Run-time error ‘1004’: Programmatic access to Visual Basic 
Project is not trusted”, follow these steps (or equivalent steps in your version of 
Excel – the steps below are for Excel 10): 
 
1.  Select File > Options. 
2.  Select Trust Center > Trust Center Settings. 
3.  Select Macro Settings. 
4.  Check “Trust access to the VBA project object model”. 
 

Postal Codes with Leading Zeroes 
 
If you enter a postal code with a leading zero (e.g. 08540) Excel may interpret it 
as a number and remove the leading zero. To correct this problem, either type an 
apostrophe in front of the postal code (e.g. ‘08540) or format the field as text 
(“Text” category of the “Format Cells” command). 
 
NOTE: In North America, the database also includes 3-digit U.S. ZIP Codes. 
 

Converting Minutes to Hour:Minute Format 
 
The DriveTime function returns the drive time between two points in minutes, 
but sometimes it is convenient to see the time in hour:minute format. To display 
drive times as “days hours:minutes” in Excel, you must first convert minutes to 
days by dividing by 24*60.  For example: 
 

=DriveTime (A2,B2)/(24*60) 
 

‘The INI File Was Not Found’ Error 
 
When loading the Add-In for the first time, this error may sometimes appear.  Exit 
and re-enter Excel. 
 

‘Sub or Function Not Defined’ Error  
 
When making calls to PC*MILER|Spreadsheets from a macro sheet, you may see 
this error message. To fix the problem, from the Tools menu select References 
and make sure that pcmsrv.xla is checked on. 

4 C
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‘-1’ Error  
 
This error occurs when the user enters a location (postal code or a city/state place 
name) that is not a valid PC*MILER location.   
 
NOTE: If you add or change custom locations in PC*MILER using “Import 
Custom Places” or “Manage Custom Places,” Excel will not recognize those 
changes until you exit PC*MILER to save the changes on disk, as well as shut 
down Excel and restart it. 
 
This error can also occur if the Add-In was not able to correctly load the 
PC*MILER database. 
 

‘Cannot Find VBAEN.OLB’ Error 
 

NOTE: We do not support making modifications to this file. Please make a 
backup copy before making any changes 
 
Excel will attempt to access this file when it tries to load the Add-In.  First, make 
sure that the file vbaen.olb exists. It should be either in the Windows folder or the 
SYSTEM sub-folder inside the Windows folder. If the file does not exist, you must 
re-install Windows. 
 
If the file exists, then the problem is in the Windows Registration File (reg.dat).  
The location of vbaen.olb is saved in the reg.dat. Make sure the path to this file 
in the reg.dat points to the correct location. You can run REGEDIT /V to 
view/edit the reg.dat. 
 
Look for the key "TypeLib". Look for the Win17 selection. Under this section 
should be a complete path to the vbaen.olb. Ensure the full path is correct. 
 

Problems Using Custom Routing From PC*MILER  
 
If you have problems using custom routing that you created in PC*MILER, set 
the value of the following item in the PCMSERVE.INI file to TRUE. The 
PCMSERVE.INI file is located in your Windows or Winnt directory. 
 
CustomRoute = TRUE 
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Appendix A: 

  State/Province/Country Abbreviations 
 

 
Jurisdictions in the United States, Canada, and Mexico 
 
States/Provinces in the United States & Canada 
(For country abbreviations in North America, see “North America” in the Country Codes section 
of this appendix)  
 

AL Alabama 
AK Alaska 
AB Alberta 
AZ Arizona 
AR Arkansas 
BC British Columbia 
CA California 
CO Colorado 
CT Connecticut 
DE Delaware 
DC Dist. of Columbia 
FL Florida 
GA Georgia 
ID Idaho 
IL Illinois 
IN Indiana  
IA Iowa 
KS Kansas 
KY Kentucky 
LA Louisiana 
ME Maine 
MB Manitoba 
MD Maryland 
MA Massachusetts 
MI Michigan 
MN Minnesota 
MS Mississippi 
MO Missouri 
MT Montana 

A A
pp

en
di

x 
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NE Nebraska 
NV Nevada 
NB New Brunswick 
NH New Hampshire 
NJ New Jersey 
NM New Mexico 
NY New York 
NL Newfoundland & Labrador 
NC North Carolina 
ND North Dakota 
NT Northwest Territory 
NS Nova Scotia 
NU* Nunavut 
OH Ohio 
OK Oklahoma 
ON Ontario 
OR Oregon 
PA Pennsylvania 
PE Prince Edward Island 
QC Quebec 
RI Rhode Island  
SK Saskatchewan 
SC South Carolina 
SD South Dakota 
TN Tennessee 
TX Texas 
UT Utah 
VT Vermont 
VA Virginia 
WA Washington 
WV West Virginia 
WI Wisconsin 
WY Wyoming 
YT Yukon Territory 
 
 

* The same FIPS code, NU, is used for Nicaragua and the province of Nunavut, Canada in the 
PC*MILER database. 
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Mexican Estados 
AG Aguascalientes 
BJ Baja California 
BS Baja California Sur 
CP Campeche 
CH Chiapas 
CI Chihuahua 
CU Coahuila de Zaragoza 
CL Colima 
DF Distrito Federal 
DG Durango 
GJ Guanajuato 
GR Guerrero 
HG Hidalgo 
JA Jalisco 
EM Mexico (Estado) 
MH Michoacan de Ocampo 
MR Morelos 
NA Nayarit 
NX * Nuevo Leon 
OA Oaxaca 
PU Puebla 
QA Queretaro Arteaga 
QR Quintana Roo 
SL San Luis Potosi 
SI Sinaloa 
SO Sonora 
TA Tabasco 
TM Tamaulipas 
TL Tlaxcala 
VZ Veracruz 
YC Yucatan 
ZT Zacatecas 

 
*  Please note that by default, “NX” is used for Nuevo Leon because the province of 

Newfoundland and Labrador in Canada already utilizes “NL” in the database.  However, there 
is an option that sets “NL” as the abbreviation for Nuevo Leon: in the File application menu, 
select Application Settings… .  In the NL Abbreviation drop-down, select Use for Nuevo Leon 
and click Save. 
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Country Codes For All Worldwide Regions 
 
Africa 

 

COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Algeria AG DZ DZA DZ DZA 
Angola AO AO AGO AO AGO 
Benin BN BJ BEN BJ BEN 
Botswana BC BW BWA BW BWA 
Burkina Faso UV BF BFA BF BFA 
Burundi BY BI BDI BI BDI 
Cameroon CM CM CMR CM CMR 
Cape Verde CV CV CPV CV CPV 
Central African Republic CT CF CAF CF CAF 
Chad CD TD TCD TD TCD 
Comoros CN KM COM KM COM 
Congo Democratic Republic (Kinshasa) CG CG COD CD COD 
Congo, Republic of the (Brazzaville) CF CD COG CG COG 
Djibouti DJ DJ DJI DJ DJI 
Egypt EG EG EGY EG EGY 
Equatorial Guinea EK GQ GNQ GQ GNQ 
Eritrea ER ER ERI ER ERI 
Ethiopia ET ET ETH ET ETH 
Gabon GB GA GAB GA GAB 
Gambia GA GM GMB GM GMB 
Ghana GH GH GHA GH GHA 
Guinea GV GN GIN GN GIN 
Guinea-Bissau PU GW GNB GW GNB 
Ivory Coast (Côte d’Ivoire) IV CI CIV CI CIV 
Kenya KE KE KEN KE KEN 
Lesotho LT LS LSO LS LSO 
Liberia LI LR LBR LR LBR 
Libya LY LY LBY LY LBY 
Madagascar MA MG MDG MG MDG 
Malawi MI MW MWI MW MWI 
Mali ML ML MLI ML MLI 
Mauritania MR MR MRT MR MRT 
Mauritius MP MU MUS MU MUS 
Mayotte MF YT MYT YT MYT 
Morocco MO MA MAR MA MAR 
Mozambique MZ MZ MOZ MZ MOZ 
Namibia WA NA NAM NA NAM 
Niger NG NE NER NE NER 
Nigeria NI NG NGA NG NGA 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Reunion RE RE REU RE REU 
Rwanda RW RW RWA RW RWA 
Saint Helena SH SH SHN SH SHN 
Sao Tome and Principe TP ST STP ST STP 
Senegal SG SN SEN SN SEN 
Seychelles SE SC SYC SC SYC 
Sierra Leone SL SL SLE SL SLE 
Somalia SO SO SOM SO SOM 
South Africa SF ZA ZAF ZA ZAF 
South Sudan OD SD SDW SS SSD 
Sudan SU SD SDN SD SDN 
Swaziland WZ SZ SWZ SZ SWZ 
Tanzania TZ TZ TZA TZ TZA 
Togo TO TG TGO TG TGO 
Tunisia TS TN TUN TN TUN 
Uganda UG UG UGA UG UGA 
Western Sahara WI EH ESH EH ESH 
Zambia ZA ZM ZMB ZM ZMB 
Zimbabwe ZI ZW ZWE ZW ZWE 
 

 
     Asia 

 

     Bangladesh BG BD BGD BD BGD 
Bhutan BT BT BTN BT BTN 
British Indian Ocean Territory IO -- -- -- -- 
Brunei  BX BN BRN BN BRN 
Burma (Myanmar) BM MM MMR MM MMR 
Cambodia CB KH KHM KH KHM 
China CH CN CHN CN CHN 
Guam GQ GU GUM GU GUM 
Hong Kong HK HK HKG HK HKG 
India IN IN IND IN IND 
Indonesia ID ID IDN ID IDN 
Japan JA JP JPN JP JPN 
Korea, North KN KP PRK KP PRK 
Korea, South KS KR KOR KR KOR 
Laos LA LA LAO LA LAO 
Macao MC MO MAC MO MAC 
Malaysia MY MY MYS MY MYS 
Maldives MV MV MDV MV MDV 
Mongolia MG MN MNG MN MNG 
Nepal NP NP NPL NP NPL 
Northern Mariana Islands CQ MP MNP MP MNP 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Pakistan PK PK PAK PK PAK 
Palau PS PW PLW PW PLW 
Papua New Guinea PP PG PNG PG PNG 
Philippines RP PH PHL PH PHL 
Singapore SN SG SGP SG SGP 
Solomon Islands BP SB SLB SB SLB 
Sri Lanka CE LK LKA LK LKA 
Taiwan TW TW TWN TW TWN 
Thailand TH TH THA TH THA 
Timor-Leste TT -- TMP TL TMP 
Vietnam VM VN VNM VN VNM 
 
 

     Europe 
 

     Akrotiri AX -- -- QZ XQZ 
Albania AL AL ALB AL ALB 
Armenia AM AM ARM AM ARM 
Andorra AN AND AND AD AND 
Austria AU A AUT AT AUT 
Azerbaijan AJ AZ AZE AZ AZE 
Belarus BO BY BLR BY BLR 
Belgium BE B BEL BE BEL 
Bosnia and Herzegovina BK BIH BIH BA BIH 
Bulgaria BU BG BGR BG BGR 
Croatia HR HR HRV HR HRV 
Cyprus CY CY CYP CY CYP 
Czech Republic EZ CZ CZE CZ CZE 
Denmark DA DK DNK DK DNK 
Dhekelia DX -- -- XD XXD 
Estonia EN EST EST EE EST 
Faroe Islands FO FO FRO FO FRO 
Finland FI FIN FIN FI FIN 
France FR FR FRA FR FRA 
Georgia GG GE GEO GE GEO 
Germany GM D DEU DE DEU 
Gibraltar GI GI GIB GI GIB 
Greece GR GR GRC GR GRC 
Guernsey GK -- -- GG GGY 
Hungary HU H HUN HU HUN 
Iceland IC IS ISL IS ISL 
Ireland EI IE IRL IE IRL 
Isle of Man IM -- IMN IM IMN 
Italy IT I ITA IT ITA 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Jersey JE -- -- JE JEY 
Kazakhstan KZ KZ KAZ KZ KAZ 
Kosovo KV -- XKS XK XKS 
Kyrgyzstan KG KGZ KGZ KG KGZ 
Latvia LG LV LVA LV LVA 
Liechtenstein LS FL LIE LI LIE 
Lithuania LH LT LTU LT LTU 
Luxembourg LU L LUX LU LUX 
Macedonia MK MK MKD MK MKD 
Malta MT M MLT MT MLT 
Moldova MD MD MDA MD MDA 
Monaco MN MC MCO MC MCO 
Montenegro MJ MNE MNE ME MNE 
Netherlands NL NL NLD NL NLD 
Norway NO N NOR NO NOR 
Poland PL PL POL PL POL 
Portugal PO P PRT PT PRT 
Romania RO RO ROU RO ROU 
Russia RS RUS RUS RU RUS 
San Marino SM RSM SMR SM SMR 
Serbia RI SRB SRB RS SRB 
Slovakia LO SK SVK SK SVK 
Slovenia SI SLO SVN SI SVN 
Spain SP E ESP ES ESP 
Svalbard and Jan Mayen Islands SV SJ SJM XR XSV 
Sweden SW S SWE SE SWE 
Switzerland SZ CH CHE CH CHE 
Tajikistan TI TJ TJK TJ TJK 
Turkey TU TR TUR TR TUR 
Turkmenistan TX TM TKM TM TKM 
Ukraine UP UA UKR UA UKR 
United Kingdom UK GB GBR GB GBR 
Uzbekistan UZ UZ UZB UZ UZB 
Vatican City VT V VAT VA VAT 

      
      Middle East 
Afghanistan AF AF AFG AF AFG 
Bahrain BA BH BHR BH BHR 
Gaza Strip GZ -- XGZ XG XGZ 
Iran IR IR IRN IR IRN 
Iraq IZ IQ IRQ IQ IRQ 
Israel IS IL ISR IL ISR 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Jordan JO JO JOR JO JOR 
Kuwait KU KW KWT KW KWT 
Lebanon LE LB LBN LB LBN 
Oman MU OM OMN OM OMN 
Palestinian Territory -- PS PSE PS PSE 
Qatar QA QA QAT QA QAT 
Saudi Arabia SA SA SAU SA SAU 
Syria SY SY SYR SY SYR 
United Arab Emirates AE AE ARE AE ARE 
West Bank WE -- XWB XW XWB 
Yemen YM YE YEM YE YEM 

    

North America 
 

Canada CA CA CAN CA CAN 
Greenland GL GL GRL GL GRL 
Mexico MX MX MEX MX MEX 
Puerto Rico* PR* PR PRI PR PRI 
Saint Pierre and Miquelon SB PM SPM PM SPM 
United States US US USA US USA 
Virgin Islands, U.S. VI VI VIR VI VIR 

* Note: “PR” for Puerto Rico is a USPS code, not a FIPS code. 
 

 

Oceania 
 

     American Samoa AQ AS ASM AS ASM 
Australia AS AU AUS AU AUS 
Cook Islands CW CK COK CK COK 
Fiji FJ FJ FJI FJ FJI 
French Polynesia FP PF PYF PJ PYF 
French Southern and Antarctic Islands FS TF ATF TF ATF 
Kiribati KR KI KIR KI KIR 
Marshall Islands RM MH MHL MH MHL 
Micronesia, Federated States of FM FM FSM FM FSM 
Midway Island MQ UM -- QM XMW 
Nauru NR NR NRU NR NRU 
New Caledonia NC NC NCL NC NCL 
New Zealand NZ NZ NZL NZ NZL 
Niue NE NU NIU NU NIU 
Norfolk Island NF NF NFK NF NFK 
Pitcairn Islands PC PN PCN PN PCN 
Samoa (Western Samoa) WS WS WSM WS WSM 
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COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Tokelau TL TK TKL TK TKL 
Tonga TN TO TON TO TON 
Tuvalu TV TV TUV TV TUV 
Vanuatu NH VU VUT VU VUT 
Wake Island WQ WQ XWK QW XWK 
Wallis and Futuna WF WF WLF WF WLF 

    
     South America 

 

     Anguilla AV AI AIA AI AIA 
Antigua and Barbuda AC AG ATG AG ATG 
Argentina AR AR ARG AR ARG 
Aruba AA AW ABW AW ABW 
Bahamas BF BS BHS BS BHS 
Barbados BB BB BRB BB BRB 
Belize BH BZ BLZ BZ BLZ 
Bermuda BD BM BMU BM BMU 
Bolivia BL BO BOL BO BOL 
Bonaire, Sint Eustatius, Saba -- -- -- BQ BES 
Brazil BR BR BRA BR BRA 
Caribbean Netherlands NT AN BES BQ BES 
Cayman Islands CJ KY CYM KY CYM 
Chile CI CL CHL CL CHL 
Colombia CO CO COL CO COL 
Costa Rica CS CR CRI CR CRI 
Cuba CU CU CUB CU CUB 
Curacao UC -- -- CUW CUW 
Dominica DO DM DMA DM DMA 
Dominican Republic DR DO DOM DO DOM 
Ecuador EC EC ECU EC ECU 
El Salvador ES SV SLV SV SLV 
Falkland Islands (Islas Malvinas) FK FK FLK FK FLK 
French Guiana FG GF GUF GF GUF 
Grenada GJ GD GRD GD GRD 
Guadeloupe GP GP GLP GP GLP 
Guantanamo Bay -- -- -- A2 AX2 
Guatemala GT GT GTM GT GTM 
Guyana GY GY GUY GY GUY 
Haiti HA HT HTI HT HTI 
Honduras HO HN HND HN HND 
Jamaica JM JM JAM JM JAM 
Martinique MB MQ MTQ MQ MTQ 
Montserrat MH MS MSR MS MSR 

 
 PC*MILER|Spreadsheets User’s Guide 54 



 

COUNTRY NAME FIPS ISO2 ISO3 GENC2 GENC3 
Nicaragua* NU* NI NIC NI NIC 
Panama PM PA PAN PA PAN 
Paraguay PA PY PRY PY PRY 
Peru PE PE PER PE PER 
Saint Barthalemy TB -- BLM BL BLM 
Saint Kitts and Nevis Islands SC KN KNA KN KNA 
Saint Lucia ST LC LCA LC LCA 
Saint Martin RN -- MAF MF MAF 
Saint Vincent and the Grenadines VC VC VCT VC VCT 
Sint Maarten NN -- SXM SX SXM 
Suriname NS SR SUR SR SUR 
Trinidad and Tobago TD TT TTO TT TTO 
Turks and Caicos Islands TK TC TCA TC TCA 
Uruguay UY UY URY UY URY 
Venezuela VE VE VEN VE VEN 
Virgin Islands, British VG VG VGB VG VGB 

 * The same FIPS code, NU, is used for Nicaragua and the province of Nunavut, Canada in the PC*MILER 
database. 

 
 
Official Sources 
 
FIPS Country Codes: 
http://geonames.nga.mil/ggmagaz/geonames4.asp and  
http://www.state.gov/s/inr/rls/4250.htm 
 
ISO2 Country Codes: 
http://www.iso.org/iso/country_codes/iso_3166_code_lists/english_country_names_and_code_elements.htm and 
http://www.iso.org/iso/english_country_names_and_code_elements#s 
 
ISO 3 Country Codes: 
http://unstats.un.org/unsd/methods/m49/m49alpha.htm 
 
GENC2 and GENC3 Country Codes (Geopolitical Entities, Names and Codes): 
Issued by the National Geospatial-Intelligence Agency 
https://www1.nga.mil/Pages/default.aspx 
 
 

 
 

 
 PC*MILER|Spreadsheets User’s Guide 55 

http://geonames.nga.mil/ggmagaz/geonames4.asp
http://www.state.gov/s/inr/rls/4250.htm
http://www.iso.org/iso/country_codes/iso_3166_code_lists/english_country_names_and_code_elements.htm
http://www.iso.org/iso/english_country_names_and_code_elements%23s
http://unstats.un.org/unsd/methods/m49/m49alpha.htm
https://www1.nga.mil/Pages/default.aspx


 

 
 

Appendix B: 
  The PCMSERVE.INI File 

 
 
You can modify the PCMSERVE.INI file to set default trip options so that these 
options are active each time you use PC*MILER|Spreadsheets.  The INI file is in 
your Windows or Windows NT folder, and can be opened using Notepad, 
Wordpad, or another text editor. 
 
Note that trip options can also be set using the PC*MILER|Spreadsheets Excel 
functions or in the PC*MILER user interface.  See section 3.13, Route Options 
and Default Settings, for the order of precedence between route options set in the 
PC*MILER user interface, those set using Spreadsheets functions, and those set 
using the PCMSERVE.INI. 
 
Settings in the INI that can be added or edited are listed below.  If you open the 
INI file, you won’t see all of these settings in it.  If any key doesn’t have a value 
or is not found in the INI file, it assumes the default value or the value set in the 
PC*MILER user interface. 

 
IMPORTANT NOTE:  Excel must be closed and reopened for INI file setting 
changes to take effect. 

 

KEY Valid Values  Description 
 

[Engine]   

ShowEngine= 0 
1 

Should Connect automatically 
start the engine (1) or not (0). 
Default = 0 
 

[Logging]   
Enable= 0 

1 
Should log files be 
generated (1) or not (0). 
Default = 0 

File=  Path/file name of log file. 

Append= 0 
1 

Append to old file (1) or write 
over (0).  Default = 0 

DisplayTi
me= 

0 
1 

When DisplayTime = 1, 
date/time are shown on 
each line in the log file. 
Default = 0 

B A
pp

en
di

x 
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[Defaults]   
CalcType= Practical 

Shortest 
National 
AvoidToll 
Air 
FiftyThree 

Set the default routing type: most 
Practical, Shortest by distance, 
favor National Network 
highways, avoid tolls, Air 
(straight line), or 53' Trailer. 
Default = Practical 
Note: Toll-Discouraged, 
National, and 53' routing are all 
based on Practical miles.  
Note Also: When 53' Trailer 
routing is selected, the National 
Network is automatically 
included – but not necessarily 
vice versa. 
 

Units= Miles 
Kilometers 

What unit of measure should 
distance be shown in. 
Default = Miles 
 

ChangeDest= TRUE 
FALSE 

When optimizing the route, 
should the trip’s destination be 
optimized also (T). 
Default = False 
 

Borders= TRUE 
FALSE 

Should the engine try to keep 
routes within the United States 
(F), or can they cross and recross 
the borders at will (T). 
Default = True 
 

HubMode= TRUE 
FALSE 

Calculate the routes from the 
origin to each stop (T), not 
through each stop (F). 
Default = False 
 

AlphaOrder= TRUE 
FALSE 

List the states in the State Report 
in alphabetical order (T) or in the 
order driven (F). 
Default = True 
 

FerryMiles=  TRUE 
FALSE 

Use ferry distances in 
mileage and cost 
calculations (T), or don’t 
use (F). 
Default = True 
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LightVehicle= TRUE 
FALSE 

Should the DLL use Light Vehicle 
routing (available if Streets data is 
installed with PC*MILER – see the 
PC*MILER User’s Guide for more 
on routing types). 
Default = False 
 

MAPPING TRUE 
FALSE 

(AS/400 parameter) 
Default = False 
 

EXPMAP TRUE 
FALSE 

(AS/400 parameter) 
Default = False 
 

[Options]   
CustomRoute= TRUE 

FALSE 
Should PC*MILER|Connect use 
Custom routing. 
Default = False 
 

HazRoute=  
(only with the 
PC*MILER|Hazmat  
add-on) 

None 
General* 
Explosive  
Inhalant 
Radioactive 
Corrosive 
Flammable 
HarmfultoWater 
 

Hazardous material routing types 
for North America are: none 
(hazmat routing disabled), 
general, explosive, inhalant, 
radioactive, corrosive, or 
flammable.  For Europe or 
Oceania, hazmat route types are: 
none, general, explosive, 
flammable, or harmful to water. 
Default (all regions) = None 
*NOTE: “General” = “Other” in 
the PC*MILER UI, they are the 
same route type and algorithm. 
 

PartialCityMatch= TRUE 
FALSE 
 

Enables the return of a city match 
on a partial match of 28 
characters. 
Default = False 
 

HistoricalRoadSpe
eds= 
 

TRUE 
FALSE 

Toggles activation of traffic data 
for use in time-based routing.  
Equivalent to the “Traffic 
Enabled” option in PC*MILER. 
Default = False 
 

TranslateAlias= TRUE 
FALSE 
 

This setting pertains to geocoding 
in PC*MILER|FuelTax. It 
changes “*” and “()” in a custom 
place name to a “Zip-City-State; 
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Address” format. 
 
 

UseUSPost
Codes= 
 
 

TRUE 
FALSE 
 

When set to TRUE, if a 5-digit 
postal code might be a U.S. or a 
Mexican code, the U.S. code will 
be used. 
Default = True (see note below) 
 

UseMexPos
tCodes= 
 
 
 

TRUE 
FALSE 
 

When set to TRUE, if a 5-digit 
postal code might be a U.S. or a 
Mexican code, the Mexican code 
will be used. 
Default = False 
NOTE: If UseUSPostCodes 
and UseMexPostCodes are 
both FALSE, or are not in the INI, 
the default U.S. code will be used.  
 

UseStreets= 
(only if Streets 
data is installed 
with PC*MILER) 

TRUE 
FALSE 
 

Should street-level (T) or 
highway-only (F) routing be used 
when stops are city names or 
postal codes. 
Default = False 
 

UseNLAbbrevInMX 
 

TRUE 
FALSE 
 

When set to TRUE, the “NL” 
abbreviation geocodes to Nuevo 
Leon in Mexico. 

 
CountryAbbrevType
= 

 
FIPS 
ISO2 
ISO3 
GENC2 
GENC3 

 
For PC*MILER|Worldwide, this 
option sets the country code 
format that will be accepted when 
using city name/country 
abbreviations as locations in 
regions other than North America. 
Default = FIPS 
 

[ConnectOptions]   
LatLonFormatDecim
al= 
 

TRUE 
FALSE 

Pertains to the function 
PCMSAddressToLatLong(),  
causing the function to return 
lat/longs in decimal degrees (e.g. 
40.348848N,74.662703W).   
When this line is not included in 
the .INI or is included but 
=FALSE, the function returns 
degrees, minutes, seconds (e.g. 
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0402056N,0743946W).  
Default = False (Note: when this 
line is not present, default = false) 
  

AvoidFavorAutoSa
ve= 

TRUE 
FALSE 
 

(PC*MILER|Connect)  This option 
can be set to TRUE to autosave 
avoids/favors on shutdown. 
Default = False (Note: when this 
line is not present, default = false) 
 

GeofenceAutoSave
= 

TRUE 
FALSE 
 

(PC*MILER|Connect)  This option 
can be set to TRUE to autosave 
geofence data on shutdown. 
Default = True (Note: when this 
line is not present, default = false) 

   
[MappingOptions]   
AvoidFavorAutoSa
ve= 

TRUE 
FALSE 
 

(PC*MILER|Mapping)  This option 
can be set to TRUE to autosave 
avoids/favors on shutdown. 
Default = False (Note: when this 
line is not present, default = false) 
 

GeofenceAutoSave
= 

TRUE 
FALSE 
 

(PC*MILER|Mapping)  This option 
can be set to TRUE to autosave 
geofence data on shutdown. 
Default = True (Note: when this 
line is not present, default = false) 

   
[Defaults]   
Region= NA 

SA 
Africa 
Asia 
Europe 
ME 
Oceania 
 

Region default is NA (North 
America).  Other regions available 
with PC*MILER|Worldwide. 
 
 

ProductName= PC*MILER 
 

 

ProductVersion= 29 Current version of PC*MILER. 
 
DLLPath= 

 
Usually  
C:\ALK 
Technologies\ 
PCMILER29\app 

 
Path to the current installation of 
PC*MILER. 
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